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Combining and exceeding the capabilities of the proven Start-Stop Universal (Audio)Transcription System
and Start-Stop PowerPlay (Video) Transcription System that have been making industry waves

since their introduction over a decade ago

Start-Stop OmniVersal Premium All-In-One Audio/Video Transcription System
provides a single solution with new powerful features
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» Perform foot-pedal activated transcription on any sound-card equipped PC using Windows™ 8,
Windows™ 7, Vista, XP, ME, 2000, or Windows™ 2003/2008 Server

» Turn your PC into a universal, high-quality transcription machine, using your feet to activate up to
separate foot pedals.

» “NEW” Convert Compressed Videos

» “NEW” Milliseconds Display

> “NEW” Silence Detection

Control the speed and playback of virtually any digital recording, whether it's audio, CDs, digital
dictation, Hollywood, compressed, proprietary-burned DVDs, video clips, streaming web videos, or
conference recordings. Easily pause, play, step-back, and fast-forward without taking your hands from
the keys or your attention away.

Start-Stop OmniVersal Premium All-In-One Audio/Video Transcription System has many robust features
such as:

Built-in SFTP/FTP Client, unparalleled audio/video file format handling, Smart Jobs Reporting, File
Splitting and Overlapping ease, advanced digital signal processing, intuitive user graphic interface,
enhanced Jobs Manager

Supporting virtually every audio format in the industry (standard and proprietary: for example, WAV,
MP3, WMA, DSS, VOX, and VOC), whatever you need to play and transcribe under foot pedal control,
Start-Stop OmniVersal Premium All-In-One Audio/Video Transcription System is the perfect multi-
purpose transcription tool to help you get the job done.

Transcription Functions: (User-assignable to any pedal) - Play, Play/Pause, Play/Pause/Back step, Stop,
Pause, Step Back, Step Forward, Rewind, Fast Forward, Insert Bookmark.

Operating Systems Supported:

Windows 98, Windows ME, Windows 2000, Windows NT 4.0, Windows XP, Windows
VISTA, Windows 7™ (32 and 64 bit CPUs and OS, all versions), Windows 8™ (all
versions except Windows Tablet RT)

Recommended Computer: Any Windows-compatible PC with a sound card, Pentium
Class, 1GHz or higher, 512 MB or more recommended.
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CONGRATULATIONS!

Thank you for purchasing the Start-Stop OmniVersal Premium All-In-One Audio/Video
Transcription System Version 2

The perfect tool for quick and efficient transcription of digitally created audio and video file formats. The pedal
system is easy to use and easy to set up and will work with almost any type of digital audio, DVD, CD, or video
file. Advanced features include Job Manager that allows you to easily organize and archive jobs, the ability to
bookmark and label sections, and of course the variable speed and variable step function to suit your
preferences.

Friendly and helpful, Start-Stop OmniVersal comes with free professional toll free technical support, plus a
one- year warranty on footswitch, 90-day warranty on headset, a 30-day money back guarantee, and free
upgrades for as long as you own our product.

Start-Stop OmniVersal has a wide range of supported audio formats, and a focus on improved workflow and
efficiency for medical transcriptionists, court reporters, conference recording, legal transcription, educators,
corporations, and government offices.

WHAT YOU’'LL NEED TO USE THE
Start-Stop OmniVersal Premium All-In-One Audio/Video Transcription System:

> APC

(laptop, portable or desktop) with the following attributes and equipment:

£ Any of the following Operating Systems Windows 8, 7, Vista, XP, and Windows
ME, 2000 or 2003/2008 Server.

Note: Start-Stop OmniVersal cannot be directly loaded onto Apple/Mac systems. You will
need a Parallel/Virtual Windows Operating System to use.

> r\Sound card and speakers or a headphone.

A USB Port
Note: Do not use a USB Hub/USB Port Extender or Laptop Docking station. The pedals need
a direct connection to your PC.
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> A microphone or audio input source, if you plan to use it for re-
recording from tapes or from a microphone. Some multimedia laptops PCs have a built-in

microphone; others require an external microphone.

WHAT IS INCLUDED WITH YOUR
Start-Stop OmniVersal Premium All-In-One
Audio/Video Transcription System:

(Complete system):

v" 1 Infinity 3 Pedal USB Footswitch

v 1 Start-Stop OmniVersal Transcription Software
on CD-ROM

v 1 Printed Instruction Manual (this manual)

v' 1 Spectra PC Headset

(Software and User Manual Only):

v' 1 Start-Stop OmniVersalTranscription Software
on CD-ROM

v" 1 Printed Instruction Manual (this manual)

(Software via Internet Digital Download delivery):
v' 1 Start-Stop OmniVersal Transcription Software
via Email Download Link
v 1 Online Instruction Manual (this manual)
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INSTALLATION INSTRUCTIONS

1. Close all open applications on your PC, and temporarily disable all anti-virus and anti-
spyware software. Then insert the Start-Stop OmniVersal Premium All-In-One
Audio/Video Transcription System installation CD-ROM into your computer (or click
download link if internet download). You do not need to disable Firewalls.

The Start-Stop installation software should begin automatically after several seconds.

Action
Selectan Action below.

Wiew User Manual on this CD
Wiew latest User Manual online
Install Software™

*Please temporarily disable your anti-virus and anti-spyware program during
installation. f your PC is part of a corporate or office network and logged in as a
limited rights user, please log back in as "admin" before starting the installation.
Thank youl

2. Please follow the on-screen instructions, and answer “OK” or “Yes” or “Next” to questions
asked.

3. When the FINISH button appears, be sure to restart your PC.

If the install software did not come up on the screen automatically as described, then you will need
to manually launch the installation. Open “My Computer,” selects the CD/DVD Drive with the Start-
Stop OmniVersal disk in it, and then double-click on “setup.exe” to install.

-

Ed o=
Start-Stop
Omniiversal

Launch the Start-Stop OmniVersal software by clicking on the icon on your desktop:

Note for IT Administrators:
If you are installing this software on a computer that is part of a corporate or office network that
has limited rights or restricted user login rights, please follow these steps:

a) Log in as Local Administrator

b) Install software (it's recommended but not required that you temporarily disable all running
programs, including anti-spyware programs).

c) After installation is complete, run the program and enter the Registration Code provided with
your license

d) Reboot the computer and log back in as the user.
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The first time you run the program, you will be asked to authenticate the software and select a

pedal:

1. Enter the Serial Number (also referred to as Registration Code) from your Invoice or
that was contained within the upgrade email. The Serial Number will consist of 4
groups of 4 alphanumeric combinations (Example: AAAA-1111-BBBB-2222). The

Serial Number is not case-sensitive.

Sernal Number

Enter your Serial Mumber located on your invoice and click Nextto continue.

Cancel ]

2. Select the type of pedal you have (“3-Pedal, USB DEFAULT” is the model that is
included with the Start-Stop OmniVersal), then click OK and follow the on-screen

directions.

4| Pedal Type
Please select the type of pedal you have:

s
SST-2 Start-Stop 2-Pedal Unit

(" | 3Pedal Serial Port

E=S/EoE =5

Cancel

(" | 3Pedal GAMEPORT

i | 3-Pedal USE (DEFAULT)

|
-

(" | Philips 3-Pedal USB

Infinity Foot
Pedals

@

Philips Foat
Pedals

If you have a Philips™ brand USB Pedal or Philips 2305 Hand-Control:

a. Select “Philips 3-Pedal USB” from above screen.

b. Install the Philips software CD-ROM that came with the pedal or hand control.
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(If you make a mistake, or want to re-start this screen, click on “Configure”...”Select Pedal Type”
from the Start-Stop OmniVersal main screen.)

3. Insert the plug of your foot pedal control into your PC.
You should hear a “doorbell chime” sound indicating that the PC recognizes that a device has

been inserted, provided your PC speakers are turned up and/or a Pop-up window indicating
“Installing Device Drivers”.

Bt

Ed
Start-Stop
4 Omniversal

Now click on the Start-Stop OmniVersal icon on your desktop.

Installation is now complete!

OVERVIEW OF FEATURES

Start-Stop OmniVersal Premium All-In-One Audio/Video Transcription System plays a large
variety of standard and non-standard digital audio/video file formats under foot pedal control,
while using your favorite word processor.

Total recording and playback compatibility with Windows™ 8, Windows 7, Vista, XP, ME, 2000, or
Windows™ 2003/2008 Server standard multimedia .WAJV files.

Support for Restricted Access Users: The Start-Stop OmniVersal software supports networked, “restricted
access” users, found on company PCs running Windows™ 8, 7, Vista, XP, ME, 2000, or 2003/2008 Server

No batteries or external power supplies are required: The OmniVersal is self-powered by your computer,
making it practical to use in battery-powered applications (for example, for use with a laptop PC).

Higher Quality Audio: Software analyzes the file format input and optimizes the audio to reduce aliasing for
improved sound quality.

Advanced Web/Custom Integration Features: For advanced users, the Start-Stop OmniVersal offers two
methods of integrating the software into your system or application: File Association, and Command Line.
Enhanced Ease of Installation on Limited Rights PCs Works well with limited user rights computers.
Silent install Version available for IT Deployment.
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Audio Formats: Supports virtually every audio format in the industry (standard and proprietary: for example,
WAV, MP3, WMA, DSS, VOX, and VOC).

Video Formats: Never download another Codec pack again. The Start-Stop OmniVersal supports
DVD, .WMV Streaming Video, Apple QuickTime™, .AVI, Real player™ and RealAudio™, .ASF, DivX™, Adobe
Flash™, MPEG-1 through MPEG-4 and many more, making Start-Stop OmniVersal a true complete video
transcriber.

Even more formats supported: Cell Phone Audio (with HIPAA-compliant encryption/decryption), Audio
playback support of 11 new multimedia formats, Support for Speex (SPX) format

Uses a single standard USB port or Serial Port on your PC, depending on which pedal you have.

Record from any audio source connected to your PC’s sound card, with record time only limited by your PC’s
hard drive capacity.

Versatile software included to activate Record, Play, Pause, Stop, Fast Forward, Rewind, Step Forward, Step
Back, and Step Back after Pause functions.

Constant-Pitch, Variable Speed (Tempo) Control - Slow playback speeds to as little as 10%, or increase
by as much as 190%, without changing the pitch of the user's voice.

Enhanced Job Manager Have Start-Stop OmniVersal automatically queue files in a “to-do” directory including
the option to include or exclude sub-directories. The software will recheck your target directory every time you load
the job queue. You can then have the software move completed files into a “finished” folder where you can archive
past jobs.

New Columns Added for Priority, Duration and Job Comments and Notes.

Automatic Notification to Transcriptionists when new dictation arrives in monitored folders and/or sub-folders, via
LAN or SFTP/FTP. You can enable an automatic pop-up window in the lower right corner of your screen, and/or
Sound notification whenever new dictation arrives into the Job Manager.

Multi-Band Frequency Equalizer - Pull voices out of the noise; improve clarity when the voices are muffled or
faint, clarify and improve audio quality for difficult recordings; reduce microphone hiss or hum, air conditioning
rumble, lawnmowers, motors, and high-frequency sounds for easier transcription; and 3 Presets/Recalls allow
saving settings for different situations

Audio Control - opens window to volume and media controls

Rip Function - Rip audio or video to an audio file.

Voice Tag - create and tag with Bookmarks specific voice sections.

Mouse-click on pedals: The pedal icons move up and down if you click on them, just as if you had pressed the
real pedals.

Separate "Step Back/Step Forward" and "Back step after Pause” STEP AMOUNT adjustment
windows.

Bookmarks lets you keep track of and save up to 16 positions within each file transcribed and recorded! Label
any bookmark with a sentence, note or phrase as a reminder. Instant click-retrieval takes you to that position.
Network Support Feature Allows multiple transcriptionists to open the same file on a network drive at once and
transcribe it. This is especially helpful when tackling a large job in a short period of time.

Automatically launches your favorite word processor You can optionally set up the Start-Stop
OmniVersal to launch your favorite word processor when you begin working.

Built-in Smart Word Line Counter - The Smart Word Line Counter lets you keep track of how many
characters and lines you’ve typed for a client or customer.

Adjustable Video Window - Video window pops up when playing videos or DVDs. Window is resize-able to
any size, and can be set to be “on top” of your favorite word processor window so that you position it to see and
hear what’s being said while typing into your document.

Multiple SAVE AS Options for Any Playable Format! - Anything you can play with the Start-Stop
OmniVersal you can save/convert to a standard format. (Save as .MP3, WAV, or True speech™ WAV).

Ability automatically to “SAVE AS True Speech™...” and “SAVE AS MP3” or “SAVE AS WAV...”
The Start-Stop OmniVersal will convert WAV files into compressed True Speech™ .WAYV audio files, with an
amazing 15:1 compression ratio compared to standard .WAYV files. For example, a 10-minute speech that would
normally require about 10 Megabytes of disk space only requires 650K if saved as True Speech™.

Manually Decrypt Encrypted Files — decrypt saved files created by Start-Stop Transport, VIS or Hands Free
only.

File Splitting and Overlapping Features - extract only the audio you need, or split a long recording into
smaller segments automatically.

Video to Audio Extraction - convert video to audio

Convert Compressed DVD’s/Videos - convert compressed videos

Page 10 of 77



Opened Recently Used Files — open previously transcribed files

Time Stamp Functions - insert time stamp into active document using pedal, hot key, and keystroke or after
time period.

Hot Key assignments — set up hot keys for Time stamps, play back and bookmarking functions.

VOX Modes - set for specific VOX flavors and formats.

Passwords & Legacy Passwords — set up passwords for decrypted files: single or multiple passwords.
Restore a previous Configuration - reset configuration to a previous version

MY Dictation Zip Audio Files Selection - associate and extract compressed files

Optional Milliseconds Display of Elapsed Time/Remaining - Time for high-accuracy audio files where
fractions of a second count, the Start-Stop OmniVersal is capable of displaying them.

Audio Extraction Path Assignments - configure path for extracted audio files

Configure Buffer — configure direct sound latency in milliseconds

Multiple Size Start-Stop OmniVersal Screen Sizes Now select from 4 different screen sizes, to suit your
taste. Operates in the foreground (always on top) or in the background.

Always On Top — set the Start-Stop OmniVersal main window to stay on top of other windows

Save Current Screen Position — set screen position of the Start-Stop OmniVersal

Configure Display Popups — pop up suppression for bookmarks and demographics

Go to Specific Elapsed time — set time frame to advance to

Detect Silence - set and bookmark silence in files

Support for Secure FTP (SFTP) as well as FTP for File Transfer - Now supports both SFTP as well as
regular FTP. Automatically upload and download work directly into your computer (and display them using the
Start-Stop OmniVersal Job Manager)

Automatic Upload/Download - Your downloaded dictation work, plus documents you're creating, can
automatically be sent to and from your computer.

Online Web-Based Built-In Help lets you click and view the latest tech tips and upgrades to get the most out
of your Start-Stop OmniVersal

Network Pro Features:
The networking feature for Start-Stop OmniVersal makes work sharing with other
transcriptionists easy and efficient.

v" New File Drag N’ Drop Feature

v" Auto-Load Last File

v" Multi-language support added (English, Spanish, and French)

v' Support for Philips™ brand USB Foot Pedals and Philips LFH2305 hand-control
in addition to industry-standard 3 pedal USB, Serial, Game Port and Start-Stop
OmniVersal 2-pedal systems

v" More seamless installation experience for all supported operating systems

(Windows™ 8, Windows 7, Vista, XP, ME, 2000, or Windows™ 2003/2008 Server )
assures ease of installation for novices and experts alike.

v' On-going addition of new format support, including DIVX audio and Voice Age
ACELP

v" NEW 3rd Generation Design for the Network Pro Job Manager Included free:
allows WORK-SHARING (each transcriptionist can see others’ status) on any
network.

v" Order of magnitude faster for large pools of transcriptionists sharing job status
(e.g., 2, 5, 10, or even 20 or more transcriptionists can simultaneously share job
status and perform on-the-fly load-level management while simultaneously
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viewing and work-sharing hundreds of dictations from multiple persons
dictating).

v Ability to designate any name you want for each user, regardless of PC’s
logged-in name for display within Job Manager

v Ability to set and designate individual “Done” folders for each transcriptionist,
with their own locations by person. Allows easy oversight and viewing by a
Manager or Supervisor for workflow and productivity.

v' Control over Job Manager refresh time and whether Automatic Refresh POP UP
shows up or not.

v' Sharing Alert feature shows you if you are playing a file that has already been

“done” by another transcriptionist.

Color-coded display messages of Job Status

Ability to search and filter match results to help you quickly find the dictations

you are looking for, even in a large list of work

AN

Operation and Functions

Start-Stop OmniVersal Premium All-In-One Audio/Video
Transcription System

Main Window Functions:

Q Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6 =l
a — — e ———
I| File Configure Window FTP/SFTP Line Counter Stopwatch Help

(W) oo0:00:00 (A 00:00:00 ELLTTS

R = S s ..
@m[s m o[z |@r sum o 100%
Step Amount Auto Backstep ‘D) w' l—lm ( I
REAL TIME I D ' =

Voice Tag Sait Equalizer Rip Volume

L 12

10°% [} 190%

W Constant Pitch

1. Title Bar provides software and file information and is located at the top of the main
window. It displays software name, version information, file name and also will indicate if
your pedal is plugged in:

& Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, IncVersion: 206 | = H ] Hi&|

Figure 1 - Software Version Information
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Figure 2 - Audio/Video File name

¢ Can't find the Start-Stop USB Foot Pedal. Please check your connections

Figure 3 - No Pedal Detected

2. Menu Bar - Lists functions available in software. File, Configure, Windows, FTP/SFTP,
Line Counter, Stop Watch and Help are the Main Tabs on this Menu Bar.

Fle Configure Window  FIP/SFTP Line Counter Stopwatch Help

M| eft 00:00:00

Time Remaining Indicator (LEFT) (Hour, Min., Sec.): Shows the amount of playback
time remaining.

) (7 00:00:00

Elapsed Time Indicator (E.T.) (Hour, Min., and Sec.): Shows the position of the
recording in progress or playback in progress. Double-clicking on this blue icon will allow
you manually to set an elapsed time for instant positioning.

Display Milliseconds: Accessible from the Configure menu, if you want to display time
to the nearest millisecond.

NOTE: Clicking on the ET symbol will toggle display function to show “Time Stamp Time” or time
that has been corrected with an offset you select in the Configure >Time Stamp Menu. See below
for more information.

5. —

Start-Stop Ultra Job Manager: The Job Manager can be initiated by clicking on the Jobs
button on the main screen, or by tapping the “hot-key” that you have assigned to make the
Job Manager pop up. (See section “Setting Up Job Manager”)
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Bookmarks Button: Click on this button to display the Bookmarks menu. You can save up
to 16 bookmarks and labels per recording (that you make yourself), or per transcription (to
mark locations in the audio clip to which you’d like to return later). You can also assign a
hotkey to activate the bookmark function, or assign one of the foot pedals automatically to
bring up the bookmarks while you're transcribing. (See section “Setting Up Bookmarks”)

Py URL

Play URL Button: Click on this button to enter the URL (web address) of any playable clip
supported by Start-Stop OmniVersal.
Example: http://www.startstop.com/samples/Reagan.wav

<D

Audio

8.

Audio Button: Click on this button to launch the Windows Audio Mixer Panel. You can
adjust your PC’s master volume, .WAV slider, the microphone slider (if you plan to use the
Start-Stop OmniVersal for making recordings).

In some cases, if you use a separate sound card with its own software, you will have to
manually launch the audio controls from your Windows Control Panel or corresponding
application included with your sound card.

9.

Player Controls: Click on these with your mouse to control play functions of the loaded
audio file. Controls available are Rewind to Start, Rewind, Play, Pause, Fast Forward,
Forward to End, Stop and Record. (See Section “File New” for recording information)
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Animated Pedal Icons: They move up and down in real time with the motion of your feet.
Also, you can click on the appropriate icon with your mouse cursor, and the pedals will move
and activate functions as if you had pressed the actual pedal with your foot. Pedal icons also
will move up and down with mouse clicks.

- ‘ 3

Step Amount

10.

11.

Step Amount Window: Whenever the Step Back or Step Forward function is activated by
pressing the appropriate foot pedal or mouse click, the recording (or playback) will go back or
go forward by the number of seconds showing in the Step Amount box. To change the Step
Amount value, merely enter a digit in terms of a whole number of seconds (from 1 to 999
seconds) and then hit Enter on the keyboard. The Start-Stop OmniVersal will automatically
“remember” your current Step Amount setting.

g >

-
, Auto Backstep

"Back step after pause” Amount Window: Whenever the Back step after pause function is
activated by releasing the foot pedal, the audio recording will back up by the number of
seconds showing in the "Back step after pause" window. To change the number of seconds,
merely enter a digit in terms of a whole number of seconds (from 1 to 999 seconds) and then
hit return on the keyboard. The Start-Stop OmniVersal will automatically “remember” your
current Back step after pause Amount setting.

— Sound
Magnifier

Sound Magnifier: When checked, the system plays the last few seconds after releasing the
play pedal at 70% of normal speed, so you don't miss that fast burst of speech. The playback
automatically returns to 100% (normal) speed after reaching the point at which you released
the pedal.

13.-

Page 15 of 77



»)

YVWoice Tag
14.

Voice Tag: Instantly find where people are talking, instead of listening to entire recording.
Automatically bookmarks an unlimited number of "Start of Voice" and "Start of Silence"
points in a recording with exact times. Set the silence threshold, zoom/pan controls for time-
line and amplitude. (See Voice Tag and Silence Detection for more information)

15.

Instant File Splitting: Splits the file at the point where the real-time slider is positioned saves
2 smaller files (“flename a” and “filename _b”).

| & [
T

|

Equalizer
16.

16-band Equalizer: Allows you to clarify recordings:

a. Reduces microphone hiss or hum, air conditioning rumble, lawnmowers, motors, & high-
frequency sounds for easier transcription

b. Boosts voice frequencies for increased clarity

c. Improves recordings where the voice is muffled, by emphasizing the higher frequencies
(consonants). Sliders from 300Hz-2.5 KHz emphasize or de-emphasize voice frequencies:
above 5KHz you can decrease high pitched interference, and from 300Hz down you can
remove low-frequency interference like motors and hum.

(.

17. Rip

Rip: Instantly Rip audio or video to an audio file
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100%

—0

18. Volume

Volume Control: Adjust the volume from 0 to 100%.

REAL TIME 02/09/04 23:28:44 Estimated
o=

19.

Real Time Slider: The slider bar can be instantly set to any position within the recording
using the mouse. Real time information is displayed in the window above the slider bar, along

with the file start date and time.

 190%

10%

SPEE 100% £, ,
o ‘Normal

SPEED control: Allows adjustment from 10% to 190% on ALL types of files. The blue 100%
pushbutton returns speed to a nominal 100% if “Constant Pitch” is checked. (See Constant

Pitch Speed Below)

v Constant Pitch

Constant Pitch Speed Control for audio and video playback. Slow down pronunciation of
words and actions without distorting voice pitch. Adjust playback speed in 1% Increments

from 10%-190% of normal.

Flle Size: 969.9K File Length = O min,, 13 sec.
Format: Wave 22050 kHz 16 bit PCM mono

File Information displayed includes: File Type (e.g., DSP Group True Speech™, PCM,
Microsoft Adaptive PCM), Sample Rate (K bits per second), Amplitude (4, 8,16 bits), Total

size in Kb., and Total Length in Hours, Minutes and Seconds
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FILE MENU FUNCTIONS:

To open the program, click on Start >Programs - Start-Stop OmniVersal or use the Start-Stop
OmniVersal icon on your desktop:

-y

Ed

Start-Stop
Omniversal

(Your icon may also be located on the Task Bar on your Desktop normally located at bottom of monitor)

Creating a “NEW” Audio Wave file:

1. Click on File &> New

Start-Stop OmniVersal Transcription (c) 2013 HTH Engineenng, Inc.Version: 20.6 J Ei
ﬁﬂa Configure Window FTP/SFTP Line Counter Stopwatch Help

New
Open. | | |
VD b ‘\ ‘\ 1‘ Audio
Save As., ]

Sound | 00%
Save As WAV lagnifier |H

1
Save As TrueSpeech (TM) ‘) . =U
Save as MP3 Voice Tag Spht Equalizer Rlp Volume
Manually Decrypt Encrypted File
SplitFile b
o Pitch

Sample Audio/Video Files

Vidan $a Auidia Dutenrtian
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2. Insert a Name for the new file. (Make note of where you stored the file.)

-

Q Q & » Computer » O5(C) » v | 42 || Search OS (C) )
o b I

Organize ~ MNew folder

 Favorites MName Date modified

B Desktop | Extacted Video to Audio 8/13/2013 7:45 PM

i Downloads MSOCache 2/9/2013 5:36 AM
=» Recent Place _ PerfLogs 7/13/2009 11:20 PM
Program Files 12/5/2013 7:14 AM
-~ Libraries Program Files (x86) 12/5/2013 7:54 AM
*» Documents ProgramData 12/5/2013 7:17 AM
& Music rht 8/15/2013 11:53 A..

&L Pictures swsetup 2/8/2013 9:03 AM

& videos SYSTEM.SAV 2/8/2013 8:09 AM
temp 11/27/2013 3:54 PM

+% Homegroup Users 2/8/2013 6:55 AM

| Windows 12/5/2013 7:04 AM
< |

File name; |[HEEH=MN R

‘& Computer

3. Click on the record button to begin new recording.

— -
Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6 { ﬂﬂu |

e i c—

File Configure Window FTP/SFTP Line Counter Stopwatch Help

00:00:00 (§  00:00:00

ORI Fﬁf

L o0
Step Amf:lunt Autn Bankstep ¢ ) @ rﬂ‘%%‘ " il”ll
Wy W :
REAL TIME . Y o O
- Voice Tag Split Equalizer Rip ‘Jolume
10% - I}  190%

SPEE  100% m ¥ Constant Pitch

Page 19 of 77



4. When finished, press the stop button to end recording.

1_ 5 » = = = /‘/
3 { 100%

j ; Magnifi '
Step Amount Auto Backstep kg ")) . :|E| ”
7 4
REAL TIME >

- Voice Tag Split Equalizer Rlp Volume

File Size: File Length =

SPEE 100% ¥ Constant Pitch Format:

5. To listen to your new recording, click File = Open and browse to your new file.

Organize = New folder

. swsetup  *  Name Date modified Type

iy SETEMEA | Program Files 12/5/2013 714 AM  File folder
D I Program Files (x86) 12/5/2013 754 AM  File folder
e ProgramData 12/5/2013 .17 AM  File folder
& Windows rht 8/15/2013 11:53 A..  File folder
g 11 E-RECOMER swsetup 2/8/20139:03AM  File folder
€2 CD Drive (F) SYSTEM.SAV 2/8/2013 809 AM File folder
€ Drive: (G temp 11/27/2013 354 PM  File folder
€3 CD Drive (H}_ Users 2/8/2013 6:55AM  File folder
*2 CD Drive (I) Windows 12/5/2013 704 A File folder
€2 CD Drive (1) /| 20120604.wav 11/13/201311:56..  Wave Sount
logFileULtxt 10/28/2013 823 A..  Text Documr

¢, Please Type in Filename.wav 12/5/2013 421 PM  Wave Soun -
I | b

File name: Please Type in Filename.wav A [Supported formats (*.3g2;%: VI

[ Open |7H Cancel ‘
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How to Play Back a File for Transcription:

1. Click on File >Open, and then browse to your favorite file.

ﬁﬁa Configure Window FTP/SFTP Line Counter Stopwatch Help

New

Open..

DVD

Save As..

Save As WAV

Save As TrueSpeech (TM)

Save as MP3

Manually Decrypt Encrypted File
Split File

Sample Audio/Video Files
Video to Audio Extraction
Convert Compressed DVDs/Videos

Close
Exit

Recently Opened Files

—

\\ DS

Audio

o 100%
Hagnifier “
. |H
VmceTag Spllt Equalizer Rlp Volume
190%
Pitch

2. You may open it by double-clicking on the file itself, or by selecting the file, then clicking the

“Open” button.

3. You may also open a file to play by just dragging the file on top of the Start-Stop

OmniVersal window.

4. You may open using the Job Manager that displays a convenient “all in one” list of jobs,
including Job Status.(refer to section on setting up Jobs Manager)
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How to Play Back a DVD for Transcription:

1. Click on File >DVD, and then browse to your favorite file.

Start-Stop OmniV - 206 -
m Configure Window FTP/SFTP Line Counter Stopwatch Help

New

Open..
DVD b OpenDVD

Open DVD Folder
Save As WAV

. 100%
agnifier ( ||| |
Save As TrueSpeech (TM) ») o :

Save as MP3 Voice Tag Split Equallzer R|p Volume
Manually Decrypt Encrypted File
Split File

Sample Audio/Video Files

Video to Audio Extraction

Convert Compressed DVDs/Videos

Save As..

, poo
Pitch

(lose
Exit

Recently Opened Files

Open DVD directly opens any DVD loaded in your DVD/CD drive.

Open DVD Folder allows you to browse to the DVD/CD folder (for multiple DVD/CD players) or

to a DVD folder located on your computer.
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Saving Files:

You can use the ‘Save as...” Functions on the File Menu and they can be converted/
changed by the filename of an existing file, Save as... WAV, True Speech ™ or as a MP3.
i Start-5top OmniVersal Transcription (c) 2013 HTH

File | Configure Window FTP/SFTP Line Counter Stopwatch Help
00 EA Camd GIIZD ()
“ - “ Audio

ound 100%

agnifier '“))) Ql ( ||I|

Voice Tag Split Equalizer Rip Volume

gineering, Inc.Version: 2.0.6

New

Save As...
Save As WAV
Save As TrueSpeech (TM)
Save as MP3
MamraHy-Beessetthicrypted File

Split File r
Sample Audio/Video Files

Widams 44 AunAdis Cidrartinm

Pitch

1. Save As... allows you to rename the file.

2. Save As WAV, True Speech ™, and MP3 — converts files to these filetype formats.

How to Operate the Manually Decrypt Encrypted Files Function

This option is used to enter encryption keys from files sent to the user by Start-Stop Transport or
Start-Stop VIS Digital Recorder. The encryption key must match identically to the sender’s key. This
key can be up to 70 characters in length. You may enter in as many encryption keys as you like.
Then you can manually decrypt a file using the file menu, Manually Decrypt Encrypted file option.

Manual decryption of HIPAA-Compliant Files - You may manually decrypt (and save) any file to the
hard drive by clicking on “Manually Decrypt Encrypted File” from the File Menu:
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W Start-Stop OmniVersal Transcription
File | Configure Window FTP /SFTP

(c) 2013 HTH Engineering, Inc.Ve

ion: 2.0.6

=17 X

Line Counter Stopwatch Help

New

Open...

DVD

Save As...

Save As WAV

Save As TrueSpeech (TM)

Save as MP3

Manually Decrypt Encrypted File
Split File

Sample Audio/Video Files

Vidan +4 Aodia Cudractinn

Manually Decrypt Saved Files created by Start-Stop
Transport, VIS, or HandsFree Only

Available Names | _v_]

00 A CIED GIITD ()
: - - - .

Qupd 100%

agnifier ‘J)) 8| ( I='||HU

Voice Tag Split Equalizer R_i_p Volume

3
Pitch

The following window will appear:

Manual ly Decrypt Files

R+ Exit Help

First: Enter Encryption Key or Use Drop

Second:

i fi
IRATGSI0ER

Click to Manually Decrypt File

Use the drop down “Available Names” box to select a name entered in by the above
procedure or just key in the encryption key.

Then click the button labeled “Second” to select and decrypt the file.

(If passwords are not set up, you will get an error stating “No Passwords defined:” see “Setting Up

Passwords”)
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-

Start- Stﬂp - k E

There is not any passwords defined.

How to Split Files

The Start-Stop OmniVersal has the ability to split files to make them more manageable.

!File Configure Window FTP/SFTP Line Counter Stopwatch Help

:00
Open...

DvD » ’ ’ | Audlc
Save As... ound

Save As WAV agnifier ( 100%

Save As TrueSpeech (TM) 'J)) & '””

Save as MP3 Voice Tag Split Equallzer Rlp Volume
Manually Decrypt Encrypted File Eila Cizas ] e L e
Split File > Save/Save As-- Split w/Detail Options

Sample Audio/Video Files Auto Split w/f Overlay and Length Options
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1. Save/Save As - - Split w/Detail Options

Source:

IC:\ProgramData\HTH Engineering, Inc\Start-Stop OmniVersal Transcription System\Sample Audio and Video Files\Sample Audio Files\Reagan.w |

Target: ([p] tag is the part counter)

IC:‘-,PngramData‘-,HTH Engineering, Inc\Start-Stop OmniVersal Transcription System\Sample Audio and Video Files\Sample Audio Files\Reagan_[p].MP3

1o T

Target Format: -
]MP3 - MPEG-1 Audio Layer 3 (*.mp3) L‘ [ Get ID3 tags from source
Artist ITag_Arftst Album ITag_A.Ibum
Bitrate: Qualty: Samplerate. . Mode: . )
Song: Tag_Song Genre: W
|128 ~||s  ~||44100 ~| |STEREO_MODE=0 ~|
Year: ITag_Year Track:  |[p]
[~ Error Protection [v Original [v Copyright | IS0 Encoding
Comment Ip,qRT Ipl
[v VBR Mode
VBR. Quality: Min VBR Bitrate: Max VBR. Bitrate: (General Information: -
| IS ﬂ 196 ﬂ I]_28 ;J v :_‘il,lm bl T_|me:0:00:13
! ABR (Instead of [~ VBR Force Min Bitrate| |Bitrate:352800
| iy Bit per sample: 16
e 5l Channels: 1
26 52 Samplerate:22050
— Split Mode:
@ Spit to I 6 parts
(" Split each l 10 seconds
 Spiit fi d Lengtl
piit range from secon l 10 eng! 30 Spit bt
Progress
Total

i
(Text colors correspond to highlighted areas in above picture)

Source - The audio file to be split

Target — Destination for the files after split is completed

General Information about the audio file to be split.

For Advanced Users:

Bitrate — Changing this increases quality of audio

ID3 Tags — provide information about the files (i.e. Artist, Album, Song, Genre etc.)

Commands in Audio Splitter Options:

Split — Start the audio splitting process

Abort — Cancels the splitting process and closes window
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2. Auto Split w/ Overlay and Length Option
g SF_:Ti't-Audioa

[Clhick o Split

= cg. [ =

File Ower Lay Seco

File Length Minutes

Exit without Split

Chylsersy yPCCShNDesktopiyhwo mp 3

[-1

NMote: Please do not close formm. Form will close
automatically_

(Text colors correspond to highlighted areas in above picture)

File Overlay Seconds — Overlap files to prevents gaps in audio

File Length Minutes — determine length of file
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Loading Sample Audio and Video Files:

Start -5top OmniVersal Transcriptio

Version: 2.0.6 ‘: [

File | Configure Window FTP /SFTP Line Counter Stopwatch Help

New :00 marks

Open...
DVD » Audlc

Save As.., ound

Save As WAV agnifier @ ( [”Hl
Save As TrueSpeech (TM) ‘ ))

Save as MP3 Voice Tag Split Equallzer Rlp Volume
Manually Decrypt Encrypted File

Split File » JJ90%

Sample Audio/Video Files
Video to Audio Extraction
Convert Compressed DVDs/Videos

Close
Exit

Recently Opened Files

Clicking on Sample Audio/Video Files launches the following Browse Window:

.+ Open a File to play. o
&' &' | . = Start-Stop.. » Sample Audio and Video Files » W Search Sample Audio a.. P
Organize ~ New folder = O @
=» RecentPlace *  Name Date modified Type |

S . | Sample Audio Files 12/5/2013 7:06 AM  File folder
. Libraries I = = = = =
I. Sample Video Files 12/5/2013 7:.06 AM  File folder
. Documents -
. Music
= Pictures 3
‘, Videos

4& Homegroup

‘& Computer
= g (\\Pcesil) (
fe= 05 (C)
i HP_RECOVEF +~ ¢ | 1l [ 3

File name: | EELlslN gl sl=] hd l3GP (*3gp:;*.3gpp;*.392;* 3¢ V]

[ Open ij Cancel l
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How to Extract Audio from Video Files

Clicking on Extract Audio from Video pulls up the following window:

b Extract Audio From Vide

Select a video file: |

CAProgramDatayHTH Engineering, IncyStart-Stop Omniversal Transcription Systemi3ample Audio and Video
Files\Sample Yideo Files\MPEG Sample.mpeg

Select Output Path:

CAProgramDatayHTH Engineering, InchStarnt-Stop Omniversal Transcription SystermSample Audio and Video II|
FilesiSample Yideo Files),

| Audio output format settings
Sound format

MiCrosoft WA [HAY) ~|

hP3 (MF3
kicrosoft

Start Audio Extraction

To define a permanent output location go to main form and select menu option 'Configure' then
'Configure Path for Audio Extraction and Converted Video'

1. Select a Video File: Browse to the file from which you would like to extract the
audio.

2. Select Output Path: Choose location to which the extracted audio should be
saved.

3. Audio output format settings: Select format for extracted audio — either a WAV
file or MP3 format.

4. Click “Start Audio Extraction” or click “Exit” to cancel.
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Closing an Audio/Video File — Click on File in the main window and click on Close.

(Clicking on the red box with white ‘X’ closes the complete program and doesn’t save recent changes made.)

W Start-Stop OmniVersal Transcripti cVersion: 2.0.6 3 =1 X

File | Configure Window FTP/SFTP Line Counter Stopwatch Help
00 (A LD ()
Open... ' ' '

Save As... ound

Save As WAV agnifier | @ ( IIHH
Save As TrueSpeech (TM) ‘ )) . :

Save as MP3 Voice Tag Split Equalizer Rlp Volume
Manually Decrypt Encrypted File

Split File » [90%

Sample Audio/Video Files Faind

Video to Audio Extraction
Convert Cgmpressed DVDs/Videos

Close
Exit

Recently Opened Files

Exiting Start-Stop OmniVersal — Click on File in the main window, then on Exit to close the

program.
(Clicking on the red box with white ‘X’ closes the complete program and doesn’t save recent changes made.)

() 2013 | cering, IncVersion: 206 o = e S

File | Configure Window FTP/SFTP Line Counter Stopwatch Help
00 D G )
Open...

it Start-Stop OmniVersal Transcripti

Save As.., ound
Save As WAV agnifier @ ( |Il| H
Save As TrueSpeech (TM) ‘ ))
Save as MP3 Voice Tag Split Equalizer Rlp Volume
Manually Decrypt Encrypted File
Split File v [20%

Pitch

Sample Audio/Video Files
Video to Audio Extraction
Convert Compressed DVDs/Videos

Close
Exit

Recently Opened Files
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Recently Opened Files — clicking on this selection shows you the most recent files opened
and allows you to open them again and quickly.

. R
&# Files Recently Opened lb@ _— -

=wW'E Sample. swf
bAarselBatman flw

i baid with the Flaxen Hair.mp3
2071 206049 wan

b Fath: Chllsers\FCCshDeskiop, I
: Fe-Open Cancel Clear List
M— —

Selecting Re-Open opens the selected file.
Selecting Cancel closes this window without file being loaded.

Clear List resets the Recently Opened Files List.
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Configure Menu

File [Configure Window FTP/SFTP Line Counter Stopwatch Help

= COM Port v
Pedal Functions...

Hot Keys

Vox Modes

Auto Play FH‘ JL ( 100%”“”
Time Stamp Functions 'EI'%TI &) — 1§

Associate Files with Start-Stop Equalizer RTp Volume

Legacy Passwords

Passwords

Select Pedal Type

Auto POPUP BookMarks

Auto Load Last File on Start Up

Language »
Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

Show Milliseconds on Display

Configure Path for Audio Extraction and Converted Video
Configure Buffer Length

Activate Last Two Pedal Up Auto Bookmark

Reset Elapsed Time to Zero Option

COM Port - Supports COM1:-COMS: serial ports if you have the serial model. COM port
must match port assigned to Serial Pedal/USB Adapter assigned in Device Manager.

File Configure | Window FTP /SFTP Line Counter Stopwatch Help

COM Port b V| COML ‘b
Pedal Functions... COM2:
4« Hot Keys COM3: Audio
A Vox Modes COM4;
Tl AutoPlay » COMS m%q il
o Time ‘_Stami:n Funr_jtlons COM6 —T
d Associate Files with Start-Stop COM7 Volume
Legacy Passwords COM8
;[;HED,! Passwords

Select Pedal Tyrpe

Page 32 of 77



Pedal Functions - Select Configure from the menu, then Pedal Functions. The following

menu will appear (2-pedal is similar, except without “Middle” column):

b# Pedal Functions ==

Rwd FFwd PlayPause Step SteStop Record Model
Back Fwa
PEDAL ASSIGNMENTS | DV
T ok = Factory Default settings Mol
function Descriplion Left Middle Riaht
Rwd Fewinds to the beginning ® e
FFwd Fast Forwards ta the end & (" |—
Play  Plays » ® e8|
Pause  Pauses o 1w w| .
otep Back  Backs up N seconds — X eg|l—c |—C
otep Fwd Steps Farward N seconds @ C |— = X Cancel
otop otops & (" |—
Record  Records & (" |—
Play/Pause withAllows the pedal to PLAY when — X6 |—
Auto-Backstep pressed, then PAUSE when
released, automatically
followed by a BACKSTEP of "N" :
ceconds. — — Check here if you want a pedal to
' ' be used far Bookmarking instead.
fime-Stamp Reporfing
(" | Start-Stop Accu-Stamp: File iz accurately time-stamped = actual start of recording

(@ Estimated Real Time for non-Start-Stop -generated WAY

File length is subtracted from file stamp time to estimate the
approxmate the firme the recording was started.

X

The Pedal Function menu allows you to assign a pedal to any transcription action on the Start-Stop

OmniVersal control panel (default settings shown for the 3-pedal model).

The Pedal settings shown above will assign the left pedal to go backward by “N” seconds (where you

choose how many seconds “N” is, from the main Start-Stop OmniVersal screen), the middle pedal
does Play/Pause/Auto-Backstep, and the right pedal goes forward by “N” seconds. If you tap the left
or right pedal, it will take you forward or backward by “N” seconds. If you continue to hold down the
left or right pedal, it will repeatedly step forward or backward, when you need to move a long way

within a recording or dictation.
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Setting Hot Keys

The Hot keys work throughout Start-Stop OmniVersal. The following is a general reference
to the Hot Keys. Further reference is made for each of the different functions Hot Keys affect.

Clicking on the Hotkeys Selection brings up the following window:

i Hotkeys Selectic

Holkey for Selfinig Bockmarks -

_ Digable ALL Hot
meta Bookmark |N|:|th|ng ﬂ + Ii ﬂ l_}{eyg

l Hot Key Assignment for Time S1amping Funclion

|N|:|thin|:_;| ﬂ + | ﬂ

Hot Key Assignmenis for Job Man3ger
"NEXT" File MNothing  «| 4 |F3
"PREVIOUS" File

||::|:1NTRDL ﬂ + ||=3

2HOWYHIDE the .
Joh Manager |N'3'th'”'-] ﬂ e |F2

el feal i |

'‘DONE"Button — |CONTROL «| + [F10

[w Automatically bark
gach file as "Daoneg"

Syslem-wide Keys for Flavback Conlrof when it's played
through to the end.

Pedal Down {ALT 4+ |UPARROW |

B
Pedal Relessed (A T ~| + [DOwNaRROW | Apply
Step Back [aT ~v| 4 |EFTARROW +|
Step Forward (AT ~| 4+ |RIGHTARROW «| Fencel
|ncreasep|a5y§§$ Nothing v | 4 [PAGEUP ~]
DecreaseF"IaSyé?EﬂEEE Nothing v | 4 |[PAGEDOWN |
=l

Feturn Flayback MNathing HORE -
SPEEDtDNDHMAL| + ~

v Disable Flayback Contral Hotkeys
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Hot keys can use multiple combinations of both Function and all keys available on the active
keyboard.

Function key selection includes: Control (CTL), Alternate (ALT), Shift and in most cases, the
selection “Nothing” may be selected for single key Hot Key Usage.

All keys available include: A — Z (Capitals only), 0 — 9, F — Keys 1 — 12 and some punctuation
marks.
(View drop down list for clarifications)

(Text colors correspond to highlighted areas in above picture)

Hot Key for Setting Bookmarks - Bookmark Hot keys enable setting specific time marks
within each audio file.

Hot Key Assignments for Job Manager — see Job Manager section for more information.
Options include ‘NEXT’ File loading, ‘PREVIOUS’ File loading, ‘SHOW/HIDE’ the Job
Manager, and the ‘Done’ button.

System-wide Keys for Playback Control — Hot keys designed for when no foot/hand pedal is
available and include the following functions: Pedal Down, Pedal Released, Step Back, Step
Forward, Increase Play Back speed, Decrease Play Back speed, and Return Playback speed
to Normal. Playback Hot keys may also be Disabled using the Checkbox at the bottom of the
window.

Disable ALL HIT KEYS disables hot keys in the Start-Stop OmniVersal. In some cases this is
useful as they may interfere with other system Hot Keys.

Automatically Mark each file as ‘Done’ when it’s played through to the end - see Jobs
Manager for more information.

Command Buttons include Apply to set all changes and Cancel to return to previous Hot Key
configuration settings.

VOX Mode

VOX Mode under Configure allows you manually to override the default decoded VOX format
used by the Start-Stop OmniVersal, when playing certain vendor non-standard files.

VOX files come in several "flavors." If it sounds wrong or sounds like noise, please try

another setting. Clicking the “VOX Playback Options” button will cause the following menu
to appear:
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( &# Vox Modes —— .. E—'@ |ﬂhj1

O Conversion Options

(@ ! Dialogic B KHz ADFCR

Alternative W0 Conversion choices

— Dialogic 8kKHz ADFChHA
[ "Bytes" Alternate Mode (Wox BKHz 8 bit PO bAu-Lanw)

( bMMode 2 (Wox 8 KHz 8 bit PChA A-Law)

MNote: WO Files come in sewveral "flawors". If it sounds wrong ar sounds like noise,
please tny another setting. If it's too slow or fast. wou can use the Speed control 1o
compensate, or select the Dialogic 8KHz setting. If all settings sound incarrect,
then the file may not actually be a o= file (check with the ariginator of the file).

If it's too slow or fast, you can use the Speed control to compensate, or select the Dialogic
8KHz setting. If all settings sound incorrect, then the file may not actually be a VOX file
(check with the originator of the file). The Start-Stop OmniVersal will remember your most
recent settings.

Auto Play

|| File | Configure | Window FTP / SFTP Line Counter Stopwatch Help

Assaciate Files with Start-Stop Equalizer Rip Volume

@ coue D IR )
Pedal Functions.. ‘ ‘
m' Hot Keys ‘ Audio
A Vox Modes S
- ¢' Auto Play » ¥ Auto-Play Launched Files
7 Time Stamp Functions TIT — 1§
RE p
u

Legacy Passwords File Length = 0 min., 6 sec.

10%
SPE}

Passwords

Select Pedal Typz

Auto Play when enabled will also play the file automatically. This is handy for selecting a
particular file, where you’re not sure of the contents of the file. This feature also

works with Windows batch files, shell commands, and DOS batch commands (e.g.,
“c:\Program Files\HTH Engineering, Inc.\Start-Stop Universal Transcription
System\StartStopV9.exe c:\My Media Clip\1.wav).
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Time Stamp Functions

- T — —— —— ——
4 Time stamp Functions il

Methods for Enai]ling the Time Stamping Feature (You may choose multiple methods to be enabled simultaneously)

Activate using the Left or Right Foot Keystroke Counting Use a Hot Key Auto Time Stamp
Pedal B T S . — Enahble Auto Time
ote: Time Stamping Stam
| Enable Kewstroke Counting to Eiitetiam cem s (55 P
AR LAEERT BIGHT IEERT e SEMD e enahbled by setting a Hotkey Enter number
automatlpally, after the flrst_ ,F in the CONFIGURE.. Hotley of seconds 0
(pedal will be assigned to be used "space” is detactad following keystrokes kenu between b - |
exclusively for entering atime stamp) (enter whale number of keystrokes) 3600
TIME™ e S
Milliseconds option is turned off
Enter time-stamp string here: & HH: AR SS
Hours Minutes Seconds
Leading Characters + TIME® + Trailing
s @ | HHMWMSS + 08 20 0
FENTERG This is a test [Realtime | Ea] | =1 | =
N
= 202 Ofzatl
018 ‘ Cancel ‘
= e E__2

Purpose and Uses of Time-Stamping

Time Stamping lets you automatically show the exact time that each person said
something. It’s useful for court reporters, movie or theater script transcription, law
enforcement interview transcription, and other similar transcription.

Since the time stamp is accurate to +/- 1 second (either in terms of elapsed time
or “corrected” or synchronized time), it’s possible to use it for video time-code
transcription, once you’ve initially set up the Hours/Minutes/Seconds Offset
desired.

TIME Milliseconds option is turned off

(| HH:MM:ES
Hours binutes seconds
® | HHMMSS+  fos | 20 ~| o M

M
L ne ol
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Example of word processor output with time stamping enabled:
(you transcribe the audio, but tap the foot pedal to enter the bolded text automatically):

Enter time-stamp string here:

Leading Characters + TIME® + Trailing

This iz atest |m|:|rnin|;|, I'm making waffles!

This is a test 00:01:02 elapsed time Hello there, how are you doing?
This is a test 00:01:04 elapsed time Doing just great, thank you!
This is a test 00:01:06 elapsed time And in the morning, I’'m making waffles!

You can enter leading and trailing characters surrounding the time stamp. For instance, if
you type “{ENTER} This is a test “ (no quotes) and “ elapsed time”...

Enter time-stamp string here:

Leading Characters + TIME®* + Trailing
H{ENTER)This is a test elapsed timel

the cursor on your word processor will return to the beginning of a new line every time you
tap the left pedal and will type in:

(Your transcription...)

“This is a test 00:01:04 elapsed time” (More Transcription...) at the beginning of the line.
You can assign the left pedal to type in text automatically, and your choice of elapsed time,
real time, or offset real time directly into your focused Word Processor screen. Check the
Enable checkbox if you want this feature. A complete list of “control characters” you can
type, in addition to numbers, letters, and punctuation, is included in Appendix B.

Note: The Quote punctuation mark (“) is the only character that is not supported for the time

stamping feature. Future releases will support entry of quote marks into the Leading and
Trailing character boxes.
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There are four ways to trigger Time-Stamping:
1. Check the Enable checkbox if you want the left or right pedal to operate the Time
Stamp. The pedal picture for the left or right pedal will change to show “Time” as its

function. _
Aoctivate using the Left or FHRiight Foot
FPedal
i HNOMNE i LEFT = RIGHT

(pedal will be assigned to be used
exclusiwvelw for entering & time stampl

2. Click the “Enable Keystroke Counting” feature. The Start-Stop OmniVersal will count
the number of keystrokes and then automatically enter a time-stamp string.

Keystroke Counting

[ Enable Kewstrake Counting to
trigger Time Stamp Functiaon

automaticallw. after the first
"space" is detected following &0 kensstrokes

(enter whole number of kewstrolkes)

3. Configure Hot Keys Menu, and choose a key that you’d like to use to activate the
Timestamp feature. The Start-Stop OmniVersal will enter a time-stamp string every
time you tap the Hotkey.

UUse a Hot Key

Mote: Time Stamping
Function can also be
enabled bw setting a Hotkew
inthe COMNFIGURE.. Hotk.aw
kAeErnu

4. Configure Auto Time Stamp — Time stamp will function after amount of time in
seconds set.

Auauto Time Stamp

Enable Auto Time
I~ Stamp

Enter nurmber

of seconds G0
betweaen 5 - |

3s00
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Associate File Types with Start-Stop OmniVersal
& Associate File Types with Start-Stop TS T T Y (S e

Associate SR files with the At Dt Click to Associate and
Associate WAV files | TECTD T Start-Stop (e.g.the Voice ' Clickto files with the étarthtop select Folder For
with the Start-Stop Aecaciate) Maohile Digital Recorder) Associate yDictation Zip Audio
Files
. . Associate Creative
Asgsociate MP3 files .
with the Star-Stop Click to Soundblaster YOCfiles Click to

with the Start-Stop

Associate Associate

- 2 Create your own custom
Associate DES files 7

; ; Agsociate Windows
. ot —enter h i .
with the Start-Stop (2., Clickto SRS Click to Mediia Player Whis files Click ta
Olympus and Philips Aszsociate Asgsociate with the Stan-Stop Acsociate
[

and Lanier Handheld
Digital Fiecorders) For example, enter "vox" (no gquotes) to
associate VO files with the Start-Stop

[ Make wour favorite word processaor automatically Browse to find YourWord l
Enahle start up whenewveryau run Start-Stop Processor |
Ok, ‘ Cancel ‘ |

Associating File Types by extension

By clicking on the button(s) shown above, you can automatically associate your desired file
types with the Start-Stop OmniVersal application. This is an advanced user feature, and is
OPTIONAL.

The normal method of playing files with the Start-Stop OmniVersal to click on File >Open
and select your file.

However, if you want the Start-Stop OmniVersal automatically to launch, load, and optionally
play a given file type (e.g., you click on a .WAYV file from My Computer or the

Windows File Explorer), then you can perform a file association by clicking on the
appropriate button above.

You can also change Default Associations in Control Panel.

Legacy Password

@Passwords E (= @

Decryption Keys {Passwords)
Note: passwords for Start-Stop Transport, VIS and HandsFree Prior o v4.0.0 {enc files)
Available Names | |

These Decryption Keys (Passwords) are set up in Start-Stop Transport and Hands Free and
offer available names for quick access.
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Passwords

&# Add/Edit Passwords e

Enter in the first two character that match the first two

characters of the file. Then hit the add button._
Cancel

Initials | Fassword |

First Two Characters of the File MName

li Add >>

Enter password here

The first two characters of a Start-Stop OmniVersal’s name will be unique to that person,
e.g., recordings made by John Smith will start with “JS” for example. Enter the first two
characters into the password manager, then enter the password in the box below, and click
the “Add” button to add it to the list. Any further Yodal dictations received from that person,
for example, will be automatically decrypted using the password you’ve entered. You can
also access the Yodal password manager from the main Start-Stop OmniVersal screen,
under Configure...” Yodal File Passwords.”

If your Start-Stop OmniVersal dictaters are using Blackberry® cell phones in conjunction
with Start-Stop Yodal for Blackberry® HIPAA-compliant dictation software, you can enable
demographic data for these types of files (Author, Priority, Reference Information,
Comments, Task ID). If the dictater has sent you an encrypted YODAL file (HIPAA-
compliant), when you first open the recording, it will prompt you for a password in the Yodal
Password Manager.

Configuring Pedal Type

Pedals are configured at the end of the install but can be changed using the Pedal Type
function.

Select Pedal Type: If you need to change the pedal type Select Pedal type as in the example
below.
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& pedal Type B e

Please select the type of pedal you have:

S5T-2 Stan-Stop 2-Fedal Unit [0]8

Cancel

() 3 Pedal Serial Port

() 3 Pedal. GAMEPORT

Infinity Foot
Fedals
[ 3-Pedal. USE (DEFALLT)

- : Philips Faot

¢ | Philips 3-Pedal USE g _ é Pepdals
Qlyrnpus

C Qlympus 3-Pedal USE g —— Foot

Auto POPUP BookMarks

Start-Stop

File | Configure | Window FTP /SETP_line Counter Stonwatch Heln
COM Port »
00: Play URL e
@ Pedal Functions... —-

Hot Keys

m Vs

L
b |3 O Auto Play v

100%
Step Amoun|  Time Stamp Functions f il ” I o
REAL TIME Associate Files with Start-Stop = —
'-’,=

Legacy Passwords
10% =— Passwords
SPEE  100% Select Pedal Type
===V Auto POPUP BookMarks
Auto Load Last File on Start Up
Language >

Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

Show Milliseconds on Display

Configure Path for Audio Extraction and Converted Video
Configure Buffer Length

Activate Last Two Pedal Up Auto Bookmark

Reset Elapsed Time to Zero Option
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Auto POPUP BookMarks: If clicked from the Configure menu, a checkmark will appear. Clicking
again will toggle it off. This allows automatic pop up of any bookmarks you have associated with a

previously opened file.

Auto Load Last File on Start Up

[ = tartftop OmniVersal Transcripti

File

00:

L eft)

—
Step Armoun

REAL TIME
-

== 3

1096

SPEEE 100%%

Pedal Functions...
Hot Keys
Wox Modes
Auto Play
Time Stamp Functions

Associate Files with Start-Stop

Legacy Passwords

Passwords

Select Pedal Type

Auto POPUP BookhMarks

Auuto Load Last File on Start Up

Language

Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

Show Milliseconds on Display

Configure Path for Audio Extraction and Converted Wideo
Configure Buffer Length

Activate Last Two Pedal Up Auto Bookmark

Reset Elapsed Time to Zero Option

100%

..:ilf”[
1

Rip Wolume

If ybu have Auto Load Last file checked, it will display the last file you loaded.

Language Settings

File | Configure

1 Lngi

Windmw  FTP £ SETP line Counter  Stonwatech - Heln

@ 00:

CIER

Step Amoun

REAL TIME
-
10%
SPEE 100%

COM Port

Pedal Functions...

Hot Keys

Vox Modes

Auto Play

Time S5tamp Functions

Associate Files with Start-Stop

Legacy Passwords

Passwords

Select Pedal Type

Auto POPUP BookMarks

Auto Load Last File on Start Up

Language

Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

Show Milliseconds on Display

Configure Path for Audio Extraction and Converted Video
Configure Buffer Length

Activate Last Two Pedal Up Auto Bookmark

Reset Elapsed Time to Zero Option

3

ieering, Inc.Version: 2.0.6 ’ ;:IL

-

(%

Rip

D

Audio

100%

..1IHH
— 9

Volume

v | English
Spanish
French

Default language is “English” but by selecting Spanish/French you can change the language
of the software requested language.
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Restore Current Config File with Previous Config File (Config = Configuration)

COM Port Mmarks
Pedal Functions... -
Hot Keys Audio

Vox Modes

Auto Play ( |||| |
Time Stamp Functions -

Associate Files with Start-Stop Equalizer 1\..I"c:-Iu me
Legacy Passwords
Passwords

Select Pedal Type

Auto POPUP BookMarks

Auto Load Last File on Start Up

Language L4
Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

Show Milliseconds on Display

Configure Path for Audio Extraction and Converted Video
Configure Buffer Length

Activate Last Two Pedal Up Auto Bookmark

Reset Elapsed Time to Zero Option

This option allows you to load a previous saved configuration. This option is helpful for
when you made specific changes for a special project or file, or you may need to reset pedal
configurations. The following window will appear when requesting a configuration change
and is based on the Date configuration was first set up:

v| +q | Search OMMI PriorConfi... 2 |
 —

Organize ~ Mew folder = - _D Q
- Favorites = Mame - Date modified Type
B Desktop | VirginConfig 12/6/2013 11:00 A..  File folder
¢ Downloads 4 PedalsOmni_20130811 140555.cfg 3/27/2013 12:05 PM  CFG File
~» Recent Place = 4 PedalsOmni_20131206 110030.cfg 9/4/2013 10:19 AM CFG File
4 PedalsOmni_20131206 110843.cfg 9/4/2013 10:19 AM CFG File

.4 Libraries
. Documents
4. Music
J=. Pictures
i, Videos

ad Homegroup

B Computer = || ] [ | >

File name: >

[ Open ]v][ Cancel ]

Select configuration file, click Open, and the following screen will appear to confirm and
request a restart of the software:
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Start-Stop OmniVersal Transcriptiona -u

| Config File updated. Program will end.. Please re-start!

oK

Select Folder for MyDictation Zip Audio Files

!§Start5top CDrminiivWersal -_1-:@ l&l
Selecting this option to define a MyDication folder wrill...
A Associate ALL Fip files with Start-Stop
27 Wihen opening a mip file the file will be examined and
al) It all files containmned in the mip is Mp3 audio files it will be assurmed
N That I
this mip file is a MyDication Zip file. The zip file will be extracted into
the path that has been defined. If the MyDication path is the same as
the
current job Mmanager path, the job manager will open automatically
| | assurming
it is mot already openaed.
b If the Zip file contains other twpe files then the installed =Zip program
wwill open to allow extraction of the zip file.
Do wou want to contimnue?

=

Select ‘Yes’ to browse to a zip Folder located on your computer or network. Select ‘No’ to cancel.

MyDictation for iPhone® HIPAA-Compliant Dictation If you have an iPhone® and your
dictater/author is using MyDictation (www.mydictation.com) HIPAA-compliant dictation

Software, Start-Stop OmniVersal can automatically decrypt Zip-encrypted MP3 clusters whenever
you double click on a hyperlink from your MyDictation account webpage. A folder can be set for
where you want the MyDictation audio files to be stored on your PC or network drive.
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Show Milliseconds on Display

o Start-Stop OmniVersal Transcription

File | Configure | Window FTP /SETP_line Counter  Stonwatch  Heln

Leff 00:0d COM Port

Pedal Functions...

Hot Keys ‘ Audio

Vox Modes
i —
i S H Auto Play i o |
Step AMOUN' e Stamp Functions ( ‘=|H|U
REAL TIME Associate Files with Start-Stop R-i.p Volume

H— Legacy Passwords

10% =———— Passwords

SPEE  100%|  Select Pedal Type

Auto POPUP BookMarks

Auto Load Last File on Start Up

Language 4

Restore Current Config File with Previous Config File
Select Folder For MyDictation Zip Audio Files

¥ Show Milliseconds on Display
Configure Path for Audio Extraction and Converted Video
Configure Buffer Length
Activate Last Two Pedal Up Auto Bookmark
Reset Elapsed Time to Zero Option

Optional Milliseconds Display of Elapsed Time and Time Remaining: Used for high-accuracy
audio files where fractions of a second count, the Start-Stop OmniVersal is capable of displaying
them. Click on Configure menu to access this feature.

Configure Path for Audio Extraction and Converted Videos

@# Output Path for E & les I  —-%

Select the Output Path for Audio Extracted from Yideo. and for

Converted ¥ideo Files:

ChProgramDatabHTH Engineering, Inc\Start-Stop Omniversal Transcription
SystemiBintExtacted_Conwverted “ideo E

Please Select your CD/DVD Drive Letter: E]

Procedure to use when Extracted/Converted AudiofvYideo Files.

(~ Use path as indicated abowve for the Extracted/Converted Files location.

& Use same path as the source file path For the Extracted/Converted Files |
location_

MNote: f source file path is a CD/DVD Drive user will be
prompted to select a different output path. I

Exit
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Choose output path for extracted audio and converted video and browse to location. Drive
selection for CD/DVD drive and source paths can also be enabled.

Configure Buffer Length

e LSagthin Millicecond: e IS s AESSENNES - =

Direct sound latency in ms {Buffer Length]

= |

A Buffer stores your audio/video information to aid in accessing multiple processes and preventing
latency on the system. At times the Buffer is not large enough and a adjustment must be made to
close the gap. Adjusting the ‘Direct sound latency’ slider can close this gap allowing seamless
operation. These settings are represented in microseconds.

160 {ms)

T

Window Menu

3 -
“ Start-S5top OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6
File Configure | Window | FTP / SFTP Line Counter
| qure [Window] FT _
@ 00:| Set Start-Stop Screen Size

Always on Top
| Save Current Screen Position

Stopwatch Help

1— 3 = Configure Display Pop-Ups
? Sl Go to Specific Elapsed Time
i Open Last File Last Position :
| REfL TIME Set Video Screen Size and Screen Position it Equalizer Rip Volume
| Select Screen Color
! Jr._::,r_ % Detect Silenc

Set Start-Stop Screen Size: Multiple Size Start-Stop Screen Sizes--Now select from 4
different screen sizes, to suit your taste. Operates in the foreground (always on top) or in the
background.
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Full Size:

A Set Start-Stop 's Screen Size. ml@ﬂlﬂ

\ !
(@i | FullSize
i _ oK
| Medium
i | Thin |
Cancel
| SuperSlim i
\

M+ -
“ Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6

File Configure Window FTP/SFTP Line Counter Stopwatch Help

(M7 00:00:00 00:00:00 [Botkmarks) m;,um

RO I_l_[—

:— IT ,—:3_ ﬁ IT Q — Sound
Step Amount Auto Backstep '))) & . [””'

REAL TIME
Voice Tag Split Equalizer Volume

L3
i 10% Y 190%
SPEED  100% [LLleniEl)  Constant Pitch
L% I e B I 3 3
Medium:
y Set Start-Stop 's Scree_{_l.SiEPa,. - - LI—MNES = ‘
I
I (i Full Size
® ! Medium =
C | Thin
- Super Slim Cancel

-
G Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6

lFiIe Configure Window FTP /SFTP Line Counter Stopwatch Help

(™7} o00:00:00 (WP  00:00:00 REALTME

Q
-

I 2 10586 lI[” "U° 190%
al oz,
Auto Backstep —_—T] SPEED 100% Mrm =1 ¥ Constant Pitch

o=

o,

&s =

Step Amount
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Thin:

@ SetStart-Stop 's Screen Size, g W e B
I S

i Full Size
I : Ok

| Medium

@i Thin

: Cancel
| SuparSlim

-
“ Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6

File Configure Window FTP/SFTP Line Counter Stopwatch Help

(W=7} o00:00:00 (WA 00:00:00 -
I««PII»»I- 1m8(Qr

Super Slim:
&# Set Start-Stop 's Screen Size g - @M
Full Size
; 0K
tedium

| R
|
- % Cancel

Thin
Super Slim
" _— . [=] gﬂ
“ Start-5top OmniVersal Transcription (c) 2013 HTH Engine... =
" File Configure Window FIP /SFTP Line Counter Stopwatch Help

;000
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Always on Top

' -
G Start-5top OmniVersal Transcription (c) 2013 HTH Engineering, IncVersion: 2.0.6

File Configure [Window} FTP / SFTP Line Counter Stopwatch Help

m 'Dﬂ:l Set Start-Stop Screen Size Play URL »

. v Always on Top i . .
Im Save Current Screen Position l |

A Configure Display Pop-Ups
3 o 9 o E 100%

;i . :
Step Amoun Go to SpemTlc EIapsed_T_lme D . ( || | ‘ |

Open Last File Last Position
REAL TIME

L[

Set Video Screen Size and Screen Position it Equalizer Volume

Select Screen Color

Detect Silence

———= -

Checking Always on Top keeps the main Start-Stop OmniVersal on top of all other windows.

Save Current Screen Position

&# Save Current Window Position E‘@Iﬂ

Save || Cancel ‘ Festare to Default ‘

If wouwant the Start-Stop screen to be positioned at
I| its current position the nexttime you use it, click
Sawve; otherwise click Cancel or Restore. |

Use to save the current screen position so that each time you start the software it appears in the
same position as the last time.

Configure Display Pop-Ups

“ Configure Display Pop-ups (Advanced) =t
I [ Surpress Bookmarks from popping up: "
¥ Surpress Demographics window from popping up
| |
0K, ‘ Cancel ‘
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Instantly Go to a Specific Elapsed Time

&# Instantly Go to a Specific Elapsed Tim; &L@#J

§| Tvpe in Elasped Time HERE

o . Bl GO to ELAPSED TIME ‘ Cancel

= — — — s T—

Instantly go to specific time as set.
Open Last File Position
Open last file loaded and advance to last time position when file was closed.

Set Video Screen Size and Screen Position

&# VIDEO WINDOW Save Current Positi.. | — || = |5

Cancel Restore to Default |

If wou want the Start-5top screen to be
positioned at its current position the next time
you use it. click Sawve; otherwise click Cancel
or Hestore.

— Check to allow the Yideo YWindow to alwanws be
on top.

For Video window - saves video window size and screen position or restores to default settings.

Select Screen Color

%3 Main Form Color | = ” (=] ”i&|

Crlar Bressis
{ Select Color ¢

" BLEMDED GREEM

PRO BLUE-GRAY (DEFALILT)

Apply To bain Farm BUSINESS GRAY

TWEETY BIRD *YELLOW/

Exit IMNT JULIP GREEM

~
~
" GRAY MIST
~
—~
~

TITAMNIUMWHITE
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Select Color:

Basic colors:

| HE EEEEF

Define Custam Colors »>

0K | Cancel |

File Configure Window FIP/SFTP Line Counter Stopwatch Help

Left E.L.
M« > 11 »

=H= .

Select your own color background to suit your style preference, by clicking Select Color and clicking
on a color or choose a Color Preset:

Example: BLENDED GREEN

Page 52 of 77



& Start-Stop OmniVersal Transcription (c) 2013 HTH Engineering, Inc.Version: 2.0.6 =B X
File Configure Window FTP/SFTP Line Counter Stopwatch Help
my URL

(W57) 00:00:00 00:00:00 mmams
= Kl =" Rl 100%
. gﬁtep Amount Auto Backstep )) & - HHH

Voice Tag Split Equalizer ‘U'-::-Iume

Estimated

File Length = 0 min., 38 sec.

Presets Include:

Blended Green

Pro Blue-Gray (Default)
Business Gray

Gray Mist

Tweedy Bird Yellow
Mint Julip Green
Titanium White

Detect Silence - Silence Detection for Audio and Video

("Voice Tag")

With Silence Detection (Voice Tagging) you may quickly go to the sections where persons are speaking.
This saves time: you don’t have to wait during silent portions until they begin speaking again. Silence

detection allows you to advance quickly past silent sections.

& VoiceTag.wav =N Eol =%
File Configure Window FTP/SFTP Line Counter Stopwatch Help

(W=7} 00:00:00 00:05:00 [BE6kmarks|
‘[— I 3 ﬁ I 2 Q,— Sound
Step Amount Auto Backstep ‘))) & - ( .”H'

REAL TIME 07/23/12 09:27:15 Estimated
-

Voice Tag Split Equalizer Volume

10% =5 190% File Size: 52.9M File Length = 5 min., 0 sec.
SPEED 100% Nﬁ"rm =1} ~ Constant Pitch Format: Wave 44100 kHz 16 bit PCM stereo
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QVoiceTag = e R

00:14 00:29 00:44 00:59 01:14 0129 01:43 0158 0213 02:28 02:43 0258 0313 03:27 03:42 03:57 0412 04:27 04:42
3000
2000
1000
L N 1 /1 111 o
-1000
-2000
-3000
3000
2000
1000 : s
0 ﬂl‘ﬂﬂt!"—r""'mrrl—mﬁﬂﬂl—nnjrm1—tl1'|"rh"—rm1rn-r—mrm-m—nn|hm—npﬂﬂ11—-r----r-- 2 2
1000 . I
-2000 - -
-3000

00:14 0029 00:44 00:59 01:44 0120 0143 01:58 02:13 02:28 0243 0258 0313 03:27 0342 0357 0442 0427 04

yF W W V' W W W W W\ :
0 1046 2146 3) 31 41123 2 B30 B3N 78I BEIRIAL A5TIOEe Vzemcal
oam

0 I 1A 22363 320 421360903 B4 B4anAG 0 PRI BETIIEL 9B

Silence Volume threshold

{value range 1-32767) 1000 Silence minimal length in milliseconds  |5pp 05 sec(s)
{min 500ms .05 Secs)

[v Create Bookharks
Detect Silence

Clicking on the Silent Detection under the menu Window->Detect Silence function or
through the Main window Voice Tag launches the window above. The example voice tag
file will mark the silent portions based on the default settings.

In the example above, the speaking parts are marked (red and blue markers) with duration
and time being noted. Range markers are on the left and right hand sides with time
markers on the top and bottom representing input settings.

These setting can be manipulated for more accuracy using:

Silence Volume threshold: Sets the mark to determine that noise below the set
threshold will be considered silence.

Silence minimal length in milliseconds: Sets the minimum length to determine
periods of silence within the file. Anything below this mark will be ignored.

Create Bookmarks: Set Bookmarks to advance to speaking parts using hot key or
pedal. (See Bookmarks section for more information.)
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.{ Bookmarks ‘ = H g H X ‘
a

FIYYYTYY VYY) i

File Transfer Protocol (FTP) / Secure File Transfer Protocol

The Start-Stop OmniVersal has an advanced FTP/SFTP Client built-in. An FTP/SFTP Client
allows you to download and upload files to a company FTP or SFTP server. These servers
are in common use in dictation and transcription for transfer of digital voice recordings to
transcriptionists, and uploading completed documents back to the server or to the end
customer.

Automatic Upload/Download: Your downloaded dictation work, plus documents you're
creating, can automatically be sent to and from your computer.

FTP allows you to transfer files between two computers on the internet. FTP is a simple
network protocol based on internet access.

SFTP is a method of transferring files between computers over a secure internet connection.

When selected, the following window appears:
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Q Mot Connected. EI@

Settings UnAttended Exit

Connect Disconnect

Files downloaded to wour FC will be sawed in this folder. and on Unattended OMNLY files will come from the
serser from this folder:

On UnAttended.. Files wou send to the server will come frorm this folder: .. and be served on the serserin this
folder:

MNarme Size Last Accessed Adtributes

Download file from Server Delete file from Server Fefresh Directory Listing |

Exit
Upload file to serer | Fename FileoOn Senrser | Create Directony on Serser |

Mot Connected.

To use FTP/SFTP you will need to configure these settings first. Click on the
SETTINGS tab to bring up the following set up screen:

&# FTP/SFTP Setup ] [ S
Connection Information

— Secure Site (SFTP) [ Download From Remote Server

FTP Server Remote Path |

FTP Port 21 File Specification =

User Name
[T Delete Remote File after download

|
|
Description | Download To |
|
|

Password

— Upload From Local
[ Use Proxy Server Remote Path |
Proxy Address | File Specification |’=_a

Proxy User Upload From |

Password | [T Move Local File After Upload
Port | Move To |
—
oK | " cancel

Full control of upload and download directories and file types are provided as shown. You
can have the files automatically “archive” to another location after you've uploaded your
typed documents, for example.
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&# FTP/SFTP Setup

Connection Information

[ Secure Site (SFTP) [~ Downlead From Remocte Server
FTP Server | 00.00.000.000 Remote Path |f
FTP Port |21 File Specification **
Description |AudiBNidEU Server Download To |
User Name
|US€T Name [~ Delete Remote File after download
Password [rrrrmns

[~ Upload From Local

[~ Use Proxy Server Remote Path |,r
Proxy Address | File Specification  x
Proxy User | Upload From |

JEE,
Password | [~ Move Local File After Upload
Port | Move To |

JE

oK Cancel

Click OK, and then click Connect to access the FTP/SFTP server as in the example
below:

&# Connected to 00.00.000.000 as User Name at 01/01/2000 10:00:00 AM (= 5|
Settings UnAttended Exit

Connect Disconnect

Files downloaded to your PCwill be sawved in this folder: and an Unattended OMNLY files will come from the
server from this folder: /

On UnAttended.. Files wou send to the server will come from this folder: .. and be sawved on the server in this
folder:

Current Serser Directone: /

MName Size | Last Accessed | Adtributes
=.
3 users Transcription < Diirsctory > Today Stuff
Download file from Server | Delete file from Server | Fiefresh Directory Listing |
Exit
Upload file to serer | Fename FileoOn Serer | Craate Directony on Server |

Connected to B9.74.219.199 as FProdealerat 12/7/2013 5:18:1 4 Ak
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@ Not Connected. EI@

Enabled Automatic Download Enahled Automatic Upload (Upload From
[ (Download From Fiemote Server on [ Local Machine Fram Fiemote Server on
FTP/SFTF Settings must be checked. FTF/SFTF Settings must be checked.

Ewveny I o Minutes Ewvery | o0 Minutes

Download Once Upload Once

Exit

Automatic Unattended Operation Screen: Automatic Unattended Operation Screen
As shown above, you can easily enter the number of minutes, and set desired operation for
uploading and downloading files automatically in the background.

Smart Word Line Count Function: The Smart Line Counter lets you keep track of how many
characters and lines you've typed for a client or customer. Line Counter is initiated by clicking on
“Line Counter” from the top of the main screen of the Start-Stop OmniVersal program.

&# Line Count Functions [ ||| S|
Check what you want Line Count to Trigger aon
I Check this box and enter how manw = 2 G
. . =chk to
kewstrokes G0 is equal to one line. I Enable Line
(enter whole number of keystrokes) Count
| CTounta Carriage Feturn as a Line [i.e <enter>)
Count a Space as a Character (This walue is not
sawed)
Counting Attribute s
& CountAll WGAliD ey Strokes on SWSTERA
Select Microsoft "'ord program to enable counting Exit
of Al %ALID Key Strokes only Bdicrosoft WWord.
" hdake sure that kdicrosoft Word is not running befare
selecting this option and click 0K before opening Check to
el =1 — Autormaticallw
Dpen This
Select avvord Frocessor program to enable e
7 counting of All WaAllD Kew Strokes anly in the
selected “Word FProcessor. (Adwvanced Usar
write To
LineCount
Lo
Count Current Line Count 9
Feset counters Print
Li c t
I when new Audio ID |niug|:|un
File is opened
Feset Clear
Feset counters Counters LineCount
ewens time Lo
I F’rog:am i Current Total Character 9
openad. Count Wiew
u] | LimneCount
Log
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Check to Enable Line Count — Checking this box enables Line Counting to take place, in
accordance with the features you’ve checked on the form.

“Check what you want Line Count to Trigger on”

You can define what a “line” of typewritten text is in the Trigger area:

1. If you check the first box, “Check this box and enter how many keystrokes is equal to one
line,” when it reaches the Xth character as you type, it will increment the Line Count by 1.

2. If you check the second box, “Count a Carriage Return as a Line,” then the Carriage
Return
will be counted as a line.

Both types of lines can be counted at once, if you have both checkboxes marked at the same

time.

Counting Attributes

Here you can decide the criteria that cause a character that you type to be “counted” or
ignored.

1. “Count All VALID Key Strokes on SYSTEM” — This will count normal keystrokes,
regardless of whether you’re typing into your word processor, email, or instant messaging
program. The software will ignore backspaces and control characters like Shift, Alt, etc.

2. “Select Microsoft Word Program” — Start-Stop’s
characters that are typed in Microsoft Word™.

Smart” technology will only count

3. “Select a Word Processor” — the software will present a list of running applications, and
you choose the one for which you want the keystrokes to be counted. Example: You run a
medical

records software form, or WordPerfect™, or other unique application. Simply make sure the
application is running before selecting this item, and the software will present a list of the
open (Active) applications. Choose the one that corresponds to your application, and it’'s
done!

“Count” Checkboxes:

1. “Reset Counters when new Audio File is opened” — If checked, every time you open a new
audio file, the Current Line Count will be reset to zero lines.

2. “Reset Counters every time Program is Opened” — If checked, the Current Line Count will
only be reset when you've closed and reopened the application.

3. If you check neither box 1. nor 2. above, then the Current Line Count and Current Total
Character Count will be recorded and grow over time, until such time as you reset it with the
Reset Counters button. The count is “remembered” even if you close the application, or shut
down your computer for the day.
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Current Line Count — Shows the current line count for billing or productivity monitoring
purposes.

Current Total Character Count — Shows how many valid total characters have been typed.

Check to Automatically Open this Form — If checked, the Line Count Function Window wiill
stay “up” visible, and will automatically pop up when you start the application.

Logging Functions
You can view, log, and print your line count information by clicking on the three buttons on
the right-hand side. To enable logging, check the box that says, “View Line Count Log.”

Stop Watch Menu

Stop Watch Feature: Allows you to keep track of your work, either by total time, or elapsed
time on a particular job. This is helpful for billing clients by the hour, or just keeping track of
how much time you’ve been working.

&# StopWatch o™
Exit Configure
P Current Time
Start Job |
00:00:00
Bt J 1124
ime on Job
1 2
Reset H 3
| 8 4
F H
CE x.t| ]
''''''''''''''''''''''''''''''' Accumulated BreakTime
00:00:00
Print Log Clear Log Copy To Clipboard

The stopwatch feature lets you create a log of time spent on each job you transcribed.
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This can be printed out or copied to the clipboard.

Help Menu
& VoiceTag.wav EI@
File Configure Window FTP /SFTP Line Counter S‘topwatch _
(W=7} o00:00:00 (WA 00:05:00 Help

Install Optional Components L
Check For Updates 4
SR o Sound About
o '_: czi\ - Q L ——
Gk
|

Step Amount Auto Backstep ' )))
REAL TIME 07/23/12 09:27:15 Estimated : = -
Voice Tag Spllt Equalizer Volume

o
10% — 190% File Size: 52.9 M File Length = 5 min., 0 sec.
SPEED 100% m ¥ Constant Pitch Format: Wave 44100 kHz 16 bit PCM stereo

Selecting Help brings the following window into view:

G Help Screen @l

Please refer to the Instruction Manual that came with your

g unit, or launch the online manual located on the Start-Stop 0K
Install CD ROM (in the '‘Documentation’ folder).

Click here to view Instruction Manual Click here to connect to our Tech Support Web Site

You can access the Instruction Manual and Technical Support Website to obtain answers to
your questions and valuable information pertaining to the Start-Stop OmniVersal.

Selecting Installed Components enables you to view additional applications to aid you in
playing files.

&b VoiceTag.wav = ol x|

File Configure Window FTP/SFTP Line Counter Stopwatch _

(W=i) o00:00:00 (WA 00:05:00 E&L Hep

Install Optional WMA CODEC Install Optional Components L4
Install WMP RunTime Codec Check For Updates L4
rie— Install Sanyo Codec About
= 3 | ;
Install K-Lite Codec Pack o
Step Amount —
e e Install True Speech Codec l
Install Windows Media Player Filter g Spht Equalizer Volume
| Install Philips CELP ACM Codec 529 M File Length = 5 min., 0 sec.
10% TS
SPEED 100% m ~ Constant Pitch Format: Wave 44100 kHz 16 bit PCM stereo
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These files are called CODECS which stands for Compression/Decompression and
code/decode; a codec is an application that make audio/video files playable on your
computer. Video and audio files are large files and a codec will shrink and un-shrink a file to
allow it to play on a computer.

When the Start-Stop OmniVersal is first loaded on your computer, basic codecs are
installed along with it. In most cases, you may never need to run additional codec files but
because of technology and formatting changes we include advanced codecs to assist your
transcription experience. The following are the advanced codecs:

Install OPTIONAL WMA CODEC/Windows Media Audio Codec: Most Windows based
computers have the Windows Media Player (WMP) installed. This codec boosts the internal
codecs already installed on the WMP. These codecs are OPTIONAL.

Install WMP Runtime Codec: This codec is designed to decode/encode Windows Media
Video (WMV), and Windows Media Audio (WMA) files. This codec is required if you don’t
have Windows Media Player installed.

Install Sanyo Codec: This codec is designed for Sanyo audio/video recorders and contains
the codec, “Sanyo ADPCM.”

Install K-Lite Codec Pack: This codec is a collection of audio and video codecs for
Microsoft Windows that enables the operating system and its software to play various audio
and video formats generally not supported by the operating system itself. K-Lite Codec Pack
also includes several related tools, including Media Player Classic Home Cinema, Media Info
Lite, and Codec Tweak Tool.

Install True Speech Codec: True Speech ™ is a proprietary audio codec produced by the
DSP Group. It is designed for encoding voice data at low bitrates, and to be embedded into
DSP chips. True Speech has been integrated into Windows Media Player in older versions of
Windows but not in later. Typically these are Wave type formatted files.

Install Windows Media Player Filter: This is a plug-in called HIK_DSFilter and is a COM
component developed for the Direct Show Technology. It's commonly used to extract,
analyze and decode digital video/audio signals from Hik Devices. The Basic plug-in is initially
loaded when installing the Start-Stop OmniVersal.

Install Philips CELP ACM Codec: This proprietary audio codec is produced by Philips for
their audio devices.

Check for Updates:
You can manually update the Start-Stop OmniVersal when new updates are ready.

&# VoiceTag.wav = ol x|

File Configure Window FTP/SFTP Line Counter Stopwatch

(W=i) o00:00:00 (WP 00:05:00 EgL Heo

- Install Optional Components L4
Manually Check For Updates | Check For Updates L4

P =y About
& 3 |—: < 2 Q — Sound e
Step Amount Auto Backstep ‘D) v ‘Ii—iii
w i
REAL TIME 07/23/112 09:27:15 Estimated
. Voice Tag Split Equalizer Volume
10% = 190% File Size: 529 M File Length = 5 min., 0 sec.

SPEED 100% m W Constant Pitch Format: Wave 44100 kHz 16 bit PCM stereo

Updates will start by clicking on the ‘Manually Check for Updates’ selection. If your software
is up-to-date, the following window will appear:
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Update Not Required @

You already have the most recent version of Start-5top
* Omniversal Transcription System installed on your system.

About Selection:

This information is provided and should be included whenever requesting Technical
Support or any general questions you may have. This window gives name of
software, version, executable date/time, website access, sales and software key
information as in the example below:

Q About the Start-5top OmniVersal Transcription System @

Start-5top OmniVersal
Transcription System
Yersion 2.0.6

Pro Network Omni

HTH Engineering. Inc

Tarpon Springs, FL 34688 LISA
YWeb Site: http: /e startstop.com
Copyright 2013, All Rights Reserved

This software is5

Click to Connect to Our Web Sitel
Click to Download and ¥iew Entire HTH Engineering. Inc. Catalog

The Software Executable Date is : 12:00:00 AbkA

Software Key: Mo Key Registered

This program is protected by copyright laws and international treaties.
Unauthorized reproduction or distribution of this program, or any part
of it rmay resultin sewvere civil and criminal penalties, and will be
prosecuted to the maximum extent possible under law. ‘
Systemn Info...

Also, to aid Technical Support in resolving issues, system info can also be obtained
through this screen.
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Job Manager Function:

The Job Manager is a multi-function database representation of all your audio and video files and
may be used to load files; mark files as DONE and move to a separated DONE folder; and enable
you to monitor usage of files using the NETWORK PRO feature.

The Job Manager may be initiated by clicking on the Jobs button on the main screen, or by tapping
the “hot-key” that you have assigned to make the Job Manager pop up. (See section “Setting Up
Job Manager Hot Keys.”)

- !"-Wn:ﬁ’iﬂ'ﬁ“

V&L em |

[ [-AProgramData\HTH Engineering, Inc\Start-Stop OmniVersal Transciiption System’Sample Audio and Video Fies\Sample Audio Fies\Reagan- MS ADF

Job /-

FleMame -

Date/Time Crealed

v

Length +|STAT = JobStatus ~

Motes

v Dlld-lrl'g

3
| 2[ReaganTrue Spee8/21/200310.00004M  [138K8
I|Reagenway  |210/2004122844AM  |5665KB 000012
4[S5T1 Greeling wav [12/13/201282137PH_ |2819KB 000006
5[True Speech Reag|12/14/1993 1025:14PM  [138KB
B|TrueSpeech Gresti|5/21/139 122100AM_ |55KB
7|DSA00053 mav | 10/724/2008 B5700PM  [1330.3KE 000011
B[DSAT00SIWMA [10/24/2008 B57.00PH  [196.9KB 000011
9[DS40005 may  |10/724/2008 85700PM  [1720.4KB 00:00:09
10[DS400054WMA. |10/24/2008857.00PM | 1688KB 000009
11| Fielwav §/21/200992336AM | 105B40KB 000200
12|Fie2wav B/21/200993140AH  |105B40KB 000200
13| Fie3 wav §20/200993331AM | 105B40KB 000200
14|Fied wav §/21/200993551AM | 10684.0KB 000200
15|4_curentsac3  |9/17/2005101756P | 309636 KB 00311
16|Reaganalc.  |B/1G/201340323PM  |2267.2K8 000012
| 17eci2ibitnda | 9/11/201380256AM | 27431 KB 00:00:08
18[SampleAll | 9/17/2001 11-1656AM  |1393KB 000008
13| PlaphlSampledas |9/3/2000 11:1312AM  |58KB
2[VNODGam  |512/2003103200AM  [15.2KB
MR el 1R weze [RFFANN 1-R0O-NN PA 160 2R LI L] ﬂ
— Acuattobs= 99 @ _. |~ Tooge ;
Loaddob| TqpU 005677 Pint || Move/Seach "“‘:Fdﬂﬁgﬁm oL [hemechler| Sellings | Delete.Job
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On the bottom of the Job Manager are some quick and “on the fly” settings.

T-T 1) Load Job - clicking this button loads the selected file (normally highlighted in|
blue) into the application. ‘
e 2) Print - allows you to print a paper copy of the Job Manager files.
b= 3) Move CURRENT “done” job - moves the selected done file to the done folder. |
4) Move ALL “done” jobs - moves all files with a “Done” status to the done
5) Change Folder - allows you to change the Jobs Path location, “On the Fly”! =,
6) Settings - set up the Job Manager on a permanent configuration (See below
for options)
7) Delete Job - completely remove/delete files from the Job Manager path. =,

You may adjust column width and screen size/position with your mouse. The Job Manager
will remember your settings for the next time. You may swap column positions and the entire
column heading by dragging your mouse or click on the small down arrow that appears to
reposition it within the column headers.

Next to the Print button is the Toggle Move/Search checkbox (circled in red above). This
allows you to search through your files for a particular file. Successive clicks of the
“Search” button will continue to display highlighted results until you get to the last item
found.

At that point, if you want to search again, move the cursor on the left side up to the
beginning of the list, and then repeat the search procedure to perform a new search, or to
repeat a search.

H Start-Stop OmniVersal Transcription System (C) 2013 All Rights Reserved, HTH Engineering, Inc. L‘: EI,J‘:_J-J
- :gramData\HTH Engineering, InchStart-Stop Omniverzal Tranzcription Spstem'S ample Audio and Video Files\S ample Audio Files\Reagar: M

Job /= File = Date/Time Created = Length = STAT = Job Statuz - Motes *  Date Creat™,

3 1 Reagan 8/21/200310:00:004M  1429KB - 08/21/03 wm
2|Reagan|8/21/200310:00.004M  [13.8KB - 08/21/03
3|Reagan,|2/10/200412:26:44 4M  |5EE.5 KB - 02/10/04
415571 Gn[1213/2M28:21:37 PM | 281.9KB . 12/1312 l]

[4] | i

D . | loage Mave CURRENT :
Loadlob |y Frint H'i"x'ﬂfﬁﬁﬂmq | n'ﬁ;nna " Vleretieb | | Patial Match - Containg s .1.] Settings | Delete Job
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Job Manager Setup

i
L

W
i'l

|

e Scdddetsoar o Oosboe Befnesihs oo Camn elecit o

— dActivabe NMetwork Data Base - MNefhwork W,
— Chveck hvene if yoas vl shase ""OMNE"" Job Manages [0 . om a

Ll Cheote
Flobte: To chamnoge b a diffesent shansd Jokbh BMamnaoges D= eeac ke
Evern FRe-LChaeck this optiorm o bhboomog o Folders Daealboag B aoos
[ ]

W — M= .cell
— Cheeck vene il pnoaa ssearst bo hrawne ive abdty o selecit mauaitiapde hlle-s st e ol
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1 . Appearance

In the appearance block you can set the following changes:
a. Save Position, Size, and Column Spacing of Job Manager — If you’re happy with the
appearance of the Job Manager, click on this button to save the changes.
b. Restore All Formatting to Factory Default — This will reset all changes made to original install
defaults.
c. Select Show/Hide/Sort Columns — Bringing up this window (shown below) allows you to
change what is shown in the Job Manager.

# Hide/Show Columns
Checked = Column is Hidden
; I~ Hide Duate Created R
I Hide Time Created Yodal Columns Super Flow
Hide Date/Time - f - f
I Created [T Hide v-Awthor [ Hide Meeting Mame [ Hide Motes 2pply
[~ Hide Length [ Hide “"-Priority [~ Hide Meeting Date [~ Hide Segment Start
[ Hide Full Path [™ Hide-Reference [ Hide Meeting Start Time [ Hide Segment End Exit
[ Hide Y-Comments [T Hide Segment Mumber [ Hide Duration
[™ Hide Motes [™ Hide-Taskld [ Hide Speaker Mame(z]
[~ Hide STAT Select One Sort I
" Zob Nursber Call In Columns Yodal Columns Super Flow
Call In Columns C Fils Name " Department " -Author " SF-Meeting Name
£ & -Priari i | i
I 1 L= Dapatment  DateCronted Secretan -Pricrity SF-teeting Date
ey ¢ Time Created " Subject " -Reference " SF-Meeting Start Time
@ i ~ SF-
 Date/Time Created “Warktppe Y-Comments SF-Segment Mumber l
i i ¢ Priori iy ~ SF-
[ Hide Subject e Fricrity -Taskld SF-Speaker Mame[s] I
@ ¢~ SF-
[ Hide worktype i~ Job Statuz it AriliEEs
@ ¢~ SF-
y -  Full Path AuthorlzerlD SF-Segment Start
™ Hide Priority " SF-Segment End
" Cument User 2
5 ~ ~ 2 3
[~ Hide Author Name  Done User Motes SF-Duration
i
I Hide Author User D ¢ Duration SR

d. Check here to make Job Manager always stay on top — This allows you always to view the
Job Manager while working and keeps this window on top of all other windows.

2 . Job Manager Path - Standard Version

The Job Manager Path allows you to point the Job Manager toward your audio/video folder.
Clicking the Change button will allow you to browse to your transcription folder.

Although you can only point to ONE folder at a time, it will monitor Sub-Folders. The Path
section allows monitoring of Sub-Folders if you check the box at the bottom.
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F B
&) Double-Click on Desired Folder then Click SAVE [

@ k:_)v <« Start... » Sample Audio'and Vide... » v | 4 | | Search Sample Audio and Vid... 2
Organize v New folder i 2] |
L Desktop (\WPccsi- + Mame } Date modified Type I
£, Local Disk (C3) -

Sample Audio Files 11/6/2013 5:22 PM
AV _LOGS

HP

a. M50Cache
my dvd i
Perflogs
PokerKing

Program Files

m m

Sample Video Files 11/6/2013 5:22 PM

m

Program Files (

ProgramData
rht - = :
File name: _ -
Save as type: -
= Hide Folders [ sawve | [ cancel
3 . Move to Done Folder Path

A powerful feature of the Start-Stop OmniVersal Job Manager is its ability to remember
which recordings or jobs you’ve transcribed, and which ones remain to be done.

Selecting Change with in this section will allow you to browse and select a DONE file
path.

There are two (2) other options available in this section:

a. Check here if you would like to be prompted for a “New File Name” for each file
when the file is moved to the DONE folder.

b. Automatically Mark each file as “DONE” when it’s played through to the end. If you
have enabled this feature from the Hotkeys setup menu, the Job Manager will
automatically mark each job as “done” when you have played the file long enough
to reach the 1 or 2 seconds remaining point in the transcription.

Checking the corresponding box activates these options.

You may also “Manually’”’ Mark the Job as “DONE”

You may select a row (using the up and down arrow keys on your keyboard, or by single-left
clicking on a row with your mouse), and then click the DONE job hot-key (default is CTRL +
F10) to mark it as “done.” If you click on the DONE hot-key again, it will mark and display that

job as “-“which means “not done.”
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4._ Auto Refresh

You may set the Job Manager to be refreshed automatically every X number of seconds, or you
may leave that option un-checked, in which case you won’t see new jobs appear until you close
and re-open the Job Manager. If you just have 2 -4 transcriptionists, you may set the Refresh
period to 60 or 120 seconds. The more transcriptionists using the Network Pro at once, the less
frequently you need to refresh. The Pop-Up control allows you to decide if you want the Job
Manager to notify you of new incoming Jobs. It can pop up a message in the lower right corner
of your screen automatically whenever new work comes in, if you enable this function.

User Name Control

If the “Enter your User Name” field is left blank, the login name that your Windows PC uses (the
name you see if you click the Start button on your PC) will be used in the Job Manager. But, let’s
say that in your organization, that PC name is LAB3391, but you'd rather have it display Debbie
as the user. Simply type Debbie into the text box, and the Job Manager will display Debbie
instead of LAB3391 (the PC’s name).

5' Folder Mole

If Folder Mole is installed and you no longer want to use Folder Mole with the Start Stop
System then check here to DISABLE Folder Mole Functions inside the application.

0. Yodal Files

This setting is to include Yodal Demographics in the Job Manager grid. If your dictaters are
using Blackberry® cell phones in conjunction with Start-Stop Yodal for Blackberry® HIPAA-
compliant dictation software, you may enable demographic data for these types of files
(Author, Priority, Reference Information, Comments, and Task ID)

7- Activate NetWork Data Base - NetWork Version

This function allows you to share jobs with other transcribers across your Network.

Important Note:
When setting up Network Pro, all transcribers that will be connected MUST NOT have their Start-Stop

OmniVersal open with the exception of the computer that is being set up. For example: If you are
installing NetWork Pro on PC1, PC2 and PC3 and you currently are working with PC1...PC2 and PC3
Start-Stop MUST BE closed to set up correctly. The same goes for PC2 and PC3: when working on
PC2, PC1 and PC3 Start-Stop software must be closed, etc.
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Multiple transcribers can see whether a given file on a shared network drive has been
"checked out" for transcribing by another person, and by whom. Only the person who is
working on the file can mark it "Done," and then everyone's Job Manager will show it as
"Done" and who completed the work.

When a transcriptionist moves the Job to the "Done" folder, all shared Job Managers update
automatically to reflect the new status.

A pool of transcriptionists can work-share their Job Managers on any folder, or any group of
sub-folders.

Transcriptionists can point their Job Managers to different folders or drives; an unlimited
number of “shared" folders can be created.

This does not require running a “server” application on a “server” PC; merely select the
folder(s) you want to share and Start-Stop units communicate via their shared LAN. System
creates a shared Microsoft Access .MDB file in the root of each folder that's being shared for
transcription.

1) Click the checkbox to begin setting up NetWork Pro.

2) Browse to the Network folder, click on it. This can be local, or on any shared network
drive. (NOTE: If folder of incoming dictation or audio files is located on a network
drive, all mapped drive letters must be the same. For example, if drive “S:\Sample
Audio Files” is the shared drive, then transcriptionists on your network who want to
share this work must all have their PCs mapped as drive “S:\Sample Audio Files”).

3) Click OK. Another menu will appear.

Start-Stop ot S

MOTEL ALL settings on the next screen for
ALL USERS sharing this Job Manager will be affected.

0K

4) On this menu, you can select the properties for the SHARED Job folder, and
designate whether you want to share sub-folders or not.
During operation with a group of transcriptionists, they will all instantly see each file
that has been checked out for transcribing (“Current User”) as well as any Jobs that
have been marked “Done” by the transcriber who completed those particular jobs.
When transcribers click “Move to Done” on their screen, all of the other
transcriptionists’ Job Managers will show “Moved to Done” for the item(s) actually
moved.
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5)

& Metwork Job Manager Settings | = BT |ﬁl

Sub Folder Options for Hetwork
If you click OK.. changes will take effect the next time you cloze
and then re-open the Job Manager if you are the only user in the
D atabase._

— Check here if you want the Job Manager to include monitoring
all of the Subfolders under the Current Folder

Check 1H pou woilld TKE theé Job manager to dizplay hile duration and |

[ itotal the duration of all files in the Job manager. [Hote: Thizs may H
izlow down opening and refrezhing the Job Manager). This applies
all_nework users

— Check here if you would like to prevent a file from being opened
by sewveral users at the same time.

rodal Files

— Would you like to include Yodal Demographics in the Job
manager grid?

oK
Cancel

Jobs can be loaded by either double-clicking on the line containing the recording you
want, or by highlighting that line with a single click then clicking Load Job button. The
actual # of total jobs is dynamically indicated to the right of the Job Button.

High Priority jobs can be marked with the “Stat” column and they’ll appear in bright
green, and are sortable by priority. -New Notes Column allows you to enter any
special notations or comments about each recording (click on the cell; an arrow will
appear, then you may begin typing) -Sortable duration column shows length in hours,
minutes and seconds

Miscellaneous checkboxes - Ability to delete multiple jobs at once in the Job Manager
is not recommended, but allowed, if you check the box to enable that feature.
Transcriptionists may also be automatically notified with a warning that the job they
are opening and playing has already been marked “Done.”

Duration Option - The duration option allows viewing file lengths of audio dictations

made in WAV, MP3, and WMA formats to be displayed in terms of minutes and
seconds as an additional column on the Job Manager.
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Book Marks

The Start-Stop will let you save up to 16 bookmarks for each transcription or recording. The
bookmarks are saved with respect to Elapsed Time. You can type in a separate text label for each
of the bookmarks to help you remember what they’re for.

& Bookmark # 2 (=l E ]
& | A A A
EED go.00:12 ] Zm

To Set Bookmark

Position your audio file to the point in time where you want the bookmark to be set, and then click
on the SET pushbutton.

OR....

Go to Configure... Pedal Configuration from the Start-Stop’s main menu screen, and set up a pedal
for Bookmarking operation by checking “Check here if you want a pedal to be used for
bookmarking instead.” Every time you tap that pedal, a bookmark will be inserted.

OR....

Use a keyboard “Hot Key” to create bookmarks instantly. You can change the hotkey assignment
by clicking on Configure....and Hotkeys from the Start-Stop OmniVersal main menu screen.

To clear a bookmark:_Click on the triangle of the bookmark you want to clear. It will turn green.
Now click on the CLEAR pushbutton to clear out the bookmark.

To go back to a bookmark: To go instantly to a bookmarked position (the audio clip will go to the
bookmarked position), just double-click on the triangle with your mouse.

To save your bookmarks: Bookmarks are automatically saved as you create them.

To delete bookmarks for the current audio file or for all audio files: Clearing the bookmarks
can be done by clicking on the “Clr ALL” button. It will ask you if you want to delete all bookmarks
for the current audio file. Answer Yes or No.

Automatic display of bookmarks previously saved: The Start-Stop Omniversal program is
“smart” and will automatically bring up the bookmark menu, if you had created or saved bookmarks
in a previous session.
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Recording Mode Bookmarks

You can perform “live” bookmarking or annotation during a recording session. The procedure for
setting and labeling bookmarks is similar to the above description. A red background will indicate
that your bookmarks are being created while recording: This is especially useful for courtroom or
deposition recording.

@ Bookmark # 3 I.‘:’...@ > ]
& | £ A L
EED go-0052 | czm
- R
[&] cn12-21-2012 Board Meeting from Old Tape System.wayv e o0 |
File Configure Window FTP/SFTP Line Counter Stopwatch Help Upgrade
@ 00-00:16 (@ 7lobs ) (60kmarks ) {@PEyurs )  i@€Eudio )
=111l =11 m (=
I N T il Y I o
Rwd FFwd Plap Pause Step Step Stop Record ‘
Hack End Left Middie  Right ®
FFEAZ FAE 12730799 00:00:00 Q-l_ 3 2 tect,
- Instant Sound Step Autg =
; h 2 grifier Arp‘-_nﬂl Backstep ~
it T e gize: File Length -
SFEED 100% F Cowsfant Fitch  Fomnat:
\

The Bookmark function maintains an audio-file/lbookmark association list under a folder called
“Bookmarks” located in your PC’s Windows folder.
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APPENDIX A — Time Stamp Control Codes (optional)

(Capitalization, brackets and spelling are very important!)

Key: Code:
BACKSPACE {BACKSPACE} or {BS} or {BKSP}
BREAK {BREAK}

CAPS LOCK {CAPSLOCK]}
DELETE {DELETE} or {DEL}
DOWN ARROW {DOWN}

END {END}

ENTER {ENTER}

ESC {ESC}

HELP {HELP}

HOME {HOME}
INSERT {INSERT}

LEFT ARROW {LEFT}

NUM LOCK {NUMLOCK]}
PAGE DOWN {PGDN}

PAGE UP {PGUP}

PRINT SCREEN {PRTSC}
RIGHT ARROW {RIGHT}
SCROLL LOCK {SCROLLLOCK}
TAB {TAB}

UP ARROW {UP}

F1 {F1}

F2 {F2}

F3 {F3}

F4 {F4}

F5 {F5}

F6 {F6}

F7 {F7}

F8 {F8}

F9 {F9}
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APPENDIX B — Common Error Screens

(Note: These errors are advanced messages and may require you to contact Technical Suppotrt .)

Motice.71 -
! =

o Invalid serial number: Please check serial number located on
your invoice!,

OK

Solution 1: Retype in the serial code humber. Because of the size and multiple letters and
number combinations, a mistyped code could cause this issue.

Solution 2: If this is your first time installing, make sure your Anti-Virus software and any
malware software is turned off. The authorization connects via the internet and it may be
blocked due to security restrictions on your computer.

Solution 3: Please contact Technical Support as there may be an activation issue.

Start-Stop = ]

I File not found;
Use Mailclippers

e i) Help

Solution 1: The above error may occur if the file format is unrecognized or the proper codecs
have not yet been loaded. This commonly refers to ZIP type files which are compressed files,
and are normal type download files from internet sources. You will need to extract the file
before playing or set up using MyDictation function.

Solution 2: Contact Technical Support.
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APPENDIX C — Troubleshooting

Issue:

Resolution:

Pedal Doesn’t Work °

Close application, unplug pedal, plug
in pedal, restart computer, restart
application

Download USB Tester — pedal needs
to be replaced if any of the pedals do
not turn red when pressed.

Application doesn’t start

Restart computer
Reinstall software

File Loads but won’t play

Restart computer

Is the file an approved format? File
Formats

If the file is on a CD/DVD, try copying
to your computer and load from this
location.

No Sound from Head Phones .

Close application, unplug headphones,
insert headphones, restart computer
Try a different USB port or audio plug,
restart application

Test sound with other software/ try
headphones on different computer if
available.

Unplug Head Phones; do you have sound
from speakers? Then Unplug speakers (if
possible) and just plug in Head Phones.
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TECH SUPPORT: Please visit Technical Support and click on Email Tech Support. You
will be given a short form to complete which will assist us in helping you as quickly as
possible.

Toll-Free Tech Support
Call us toll-free (USA 48 States) 1 (866) 254-0714 x1 Monday - Friday 9:00 AM - 6:00 PM,
Saturday 11:00 AM-1:00 PM Eastern Time (Florida) - within the USA.

If you’re outside the USA, call (727) 939-8853. We want you to be completely happy with your
purchase. We will be glad to answer any questions you have about setup, installation or use.

FAX Tech Support

FAX us at (810) 821-6940. Please include the following information: Your Name, Company
Name, Address, Telephone Number, Date Purchased, Type of Product(s) purchased from
HTH Engineering, Detailed information on the type of computer you are using, detailed
description of your problem or question.

High Speed Internet Users

For those customers who are using high speed internet connections, we can assist through
web conferencing with GoToMeeting™ or GotoAssist™. These products allow the support
technicians to view your computer remotely and assist you just like they were sitting right in
front of your computer.

LIMITED WARRANTY

This unit is guaranteed against defects in material or manufacture for a period of 1 year from
the date of original purchase. Please call (727) 939-8853 or (866) 254-0714 (Toll-Free USA &
Canada) to initiate repair procedures and be given the address for returns (RMA# required).
Headsets have a 90-day warranty.

The unit will be repaired or replaced, at seller’s discretion. Shipping costs cannot be
refunded. No other warranties are expressed or implied. Seller accepts no liability for fithess
for use in intended application. Liability is limited strictly to the purchase price of the unit.

HTH Engineering, Inc.,

Tarpon Springs, Florida

Phone: (727) 939-8853 FAX (810) 821-6940 !
Website: http://www.startstop.com ®

111 i

Notes -Windows is a registered trademark of Microsoft Corporation -Direct-X is a registered
trademark of Microsoft Corporation -True speech is a registered trademark of the DSP Group
-Dialogic™, Play All™, Digital Voice ™, Dictaphone ™, DVIPS™, Crescendo™ and Sun™
Microsystems, ProCat™, Creative SoundBlaster™, iPhone®, Blackberry® are all registered
trademark of their respective companies. -Specifications subject to change without notice. Not
responsible for typographical errors.

Copyright © 1998-2013 by HTH Engineering, Inc. All Rights Reserved Rev 2.0.6®

Page 77 of 77



